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European Union Science Olympiad 

Die EUSO ist ein naturwissenschaftlicher Teamwettbewerb der Europäischen Union für 

Biologie, Chemie und Physik. Österreich war 2019 zum schon zwoelften Mal mit zwei 

Teams bei der EUSO, die heuer in Lissabon stattfand, vertreten. 

Das Credo der EUSO 

• begabten SchülerInnen die Möglichkeit geben, ihre Talente zu         entfalten

• Das Interesse an Wissenschaft und des forschenden Lernens zu wecken bzw. zu 

fördern

• Durch die Eindrücke und Erfahrungen der EUSO auf eine mögliche Teilnahme an 

weiteren Internationalen Olympiaden vorzubereiten

Ziel des Wettbewerbs 

• Öffentliche Interesse auf die naturwissenschaftliche Ausbildung lenken

• Ermittlung der besten SchülerInnen der Europäischen Union im

naturwissenschaftlichen Bereich

• Wertschätzung der Wissenschaft in der Allgemeinheit

• Intensivierung der Zusammenarbeit zwischen europäischen Bildungssystemen

• Individuelle Ideen und Konzepte innerhalb der gesamten Europäischen Union zu

verbreiten

• Vorbereitung europäischer SchülerInnen auf die Internationalen Facholympiaden

Mehr dazu unter: www.euso.eu  und www.euso.at 

http://www.euso.eu/
http://www.euso.at/
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1. Vorbereitungswoche an der BIKO mach MINT

33 SchülerInnen aus sechs Bundesländern, wurden, organisiert vom Regionalen Netzwerk Kärnten, 

vom 28. Jänner.-1. Februar. 2019 an der Bildungskooperation BIKO mach MINT am Educational Lab 

des Lakeside Parks Klagenfurt auf den Teamwettbewerb in Slowenien vorbereitet.  

Bittner Elena BG/BRG Perchtoldsdorf 

Bonfert Fabian BRG 18 Wien 

Catharin Amelie Sir Karl Popper Schule 

Dorfer Paul Gymnasium Tamsweg 

Eminger Simon Sir Karl Popper Schule 

Esterl Johannes BG/BRG Mössingerstraße Klagenfurt 

Friedrich Iris Sir Karl Popper Schule 

Friedrich Isabelle-Catherine Sir Karl Popper Schule 

Girstmair Birgit Peraugymnasium Villach 

Grosinger Philipp Sir Karl Popper Schule 

Grubmüller Lena Sir Karl Popper Schule 

Hofer Moritz BRG Zell am See 

Högn Tobias BG/BRG Perchtoldsdorf 

Hohl Elias Bischöfliches Gymnasium Graz 

Kalla Victoria BG/BRG Mössingerstraße Klagenfurt 

Klaus Sophie Europagymnasium Klagenfurt 

Klimisch Thomas BG/BRG Carnerigasse Graz 

Köhldorfer Anna Bischöfliches Gymnasium Graz 

Kretz Nicole Peraugymnasium Villach 

Lu Jiwei Alexander Polgargymnasium Wien 

Miklautz Anna Europagymnasium Klagenfurt 

Mirković Elena Lucia Peraugymnasium Villach 

Neumeister Kerstin BORG Deutschlandsberg 

Rainer Eva Maria BORG Wiener Neustadt 

Rainer Markus Gymnasium Zell am See 

Robič Dalena BRG Leibnitz 

Rost Lukas Bundesgymnasium St. Pölten 

Schrei Anna Elena BRG Leibnitz 

Steiner Amelie BRG Leibnitz 

Stepman Helene Gymnasium Schillerstraße Feldkirch 

Taschler Christopher HTL1 Lastenstraße Klagenfurt 

Vavra Elisabeth Sir Karl Popper Schule 

Werner Christopher HTBLA Eisenstadt 
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2. Trainingstage an der BIKO mach MINT in Klagenfurt

Sechs Jugendliche schafften es in die Qualifikation und somit zum Intensivtraining, das heuer wieder 

in Kooperation mit dem deutschen EUSO-Nationalteam ebenfalls am Lakeside Park in Klagenfurt 

stattfand (8. - 12. April 2019). Diese Trainingstage mit den deutschen EUSO KandidatInnen waren 

sind inzwischen zur Tradition geworden und werden von der Teamleitung beider Länder als äußerst 

produktiv (Bericht des IPN Kiel)gewertet. 

Insgesamt beteiligte TrainerInnen in Klagenfurt 

TrainerIn Stamminstitution Fach 

Mag Brachtl Karl RN Kärnten 

Mag. Holub Peter RN Kärnten 

Mag. Holub Sigrid RN Kärnten 

Dr. Morgenstern Christina PH Kärnten, Bundeslehrerin 

Mag. Winkler Dieter Bischöfliches Gymnasium Graz, Bundeslehrer 

Lederbauer Magdalena Schülerin der Karl Popper Schule 

Lobnig Stefan NMS St Ursula, Landeslehrer 

Dr. Willitsch Peter Physiklehrer im Ruhestand 

3. EUSO 2019 in Portugal

Die Organisation in Almada war ausgezeichnet. Das Freizeitprogramm war sehr spannend, die 

Aufgabenstellungen fordernd, Fächer übergreifend und gut vorbereitet, allerdings extrem 

schwierig. Vor allem, weil sie in der Zeit kaum bewältigbar waren. Das kam unserem erfahrenen 

A-Team entgegen, das mit diesem Setting hervorragend zurechtkam.

4. Team AUSTRIA 2019

Delegationsleitung: Mag. Peter Holub 

Mentorin Biologie: Dr. Christina Morgenstern 

Mentor Chemie: Mag. Karl Brachtl 

Mentor Physik: Mag. Dieter Winkler 

Team A: Elias Hohl, Victoria Kalla, Sophie Klaus, Goldmedaille 

https://www.ipn.uni-kiel.de/de/das-ipn/nachrichten/team-deutschland-wird-europameister-bei-der-17-europaeischen-scienceolympiade-in-almada-portugal
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Team B: Moritz Hofer, Lukas Rost, Johannes Esterl, Bronzemedaille 

5. Erstes Gold seit 2015, sowie einmal Bronze in Almada!

Anlässlich der diesjährigen Europäischen Science Olympiade in Portugal kann Österreich einen 

großen Erfolg vorweisen. Unser A-Team errang den hervorragenden 5. Platz bei 50 

teilnehmenden Teams und damit eine der begehrten sechs Goldmedaillen! Renommierte 

Nationen wie Ungarn und die Tschechische Republik rangieren dahinter. Auch unser junges B-

Team schlug sich ausgezeichnet, verpasste Silber nur um 0,5 Punkte (maximale Punktezahl: 

720). 

Goldmedaillen 

1 Victoria Kalla 
2 Elias Hohl 
3 Sophie Klaus 
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Die österreichische Delegation in Portugal 2019 

 
Von links nach rechts hinten: Dr. Christina Morgenstern, RECC für Naturwissenschaften der Pädagogischen Hochschule 

Kärnten, Mentorin Biologie, Lukas Rost, BG/BRG St. Pölten, Team B, Victoria Kalla, BG/BRG Mössingerstraße, Team A, Tomás 

Chora, guide, Mag. Dieter Winkler, Bischöfliches Gymnasium Graz, Mentor Physik, Moritz Hofer, BRG Zell am See, Team B, 

Mag. Karl Brachtl, RN Kärnten, Mentor Chemie, Mag. Sigrid Holub, NAWImix, Trainerin Biologie, Mag. Peter Holub, RN 

Kärnten und BIKO mach MINT, Bundeskoordinator, vorne: Sophie Klaus, Europagymnasium Klagenfurt, Team A. Elias Hohl, 

Bischöfliches Gymnasium Graz, Team A, Johannes Esterl, BG/BRG Mössingerstraße Klagenfurt, Team B. 

 
 
 
 

Sowohl die Trainingswoche im März als auch die Trainingstage mit den deutschen 

Nationalteams im April wurden vom Regionalen Netzwerk für Naturwissenschaften und 

Mathematik Kärnten koordiniert und fanden in den brandneuen Experimentierräumen der 

Bildungskooperation BIKO mach MINT am Educational Lab, Lakeside Park Klagenfurt statt. 

Drei der sechs Goldmedaillen entsprangen dieser Trainingsgemeinschaft, in der als TrainerInnen 

auch Magdalena Lederbauer, Schülerin der Sir Karl Popper Schule, Dr. Peter Willitsch, NAWImix 

und Stefan Lobnig, BIKO mach MINT, einen wesentlichen Teil zum Erfolg geleistet haben.  
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6. Unterstützung durch 
 
 
 
   Land Kärnten 
 
 
 
 
   Klagenfurt am Wörthersee 
 
 
 
 
   Industriellenvereinigung Kärnten 
 
 
 
   Stadt Villach  
 
 
 
   Regionales Netzwerk für  
   Naturwissenschaften und Mathematik Kärnten 
 
 
 
 
   IMST- Innovationen machen Schulen Top 
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7. Anhang – Aufgabenstellungen 2019 
 
 
 

TASK 1 CORK 
 
INTRODUCTION 
 

Cork is a plant tissue formed by cells filled with a gas mixture similar to air and bound by natural 

polymers, the main components being suberin (45%), lignin (27%) and polysaccharides (12%). This 

extraordinary product of nature is nothing more, nothing less than the bark of the cork oak, the only 

tree with an auto renewable bark.  

Portugal accounts for almost 50% of the global cork oak area and is the largest cork producer in the 

world, contributing with 55% of the annual world production.  

Cork removal is performed only by specialized professionals who manage to extract the bark without 

damaging the tree so that the oak can be stripped every nine years. However, a cork oak needs to be 

25 years old before it can be stripped for the first time. This first cork can be used as raw material 

for thermal and acoustic insulation products. Cork is widely exploited due to its unique properties 

and today its industrial application goes far beyond cork stoppers and cork flooring. For example 

the Vega rocket from the European Space Agency's (ESA) was launched into space in 2012 and, in 

order to prevent the rocket from overheating, cork was placed in the nose cone and other areas 

sensitive to temperature. In a Sustainable Development context, cork can play a relevant role, 

because it is a natural, renewable, recyclable and non-toxic resource, with exceptionally good 

environmental qualities, and a high potential of innovative technological characteristics. 

On a trip to the province of Alentejo, two friends, Vasco and Isabel, were very surprised when they 

saw large beautiful trees which bark had just been removed.  

They approached the workers and asked if that process might harm the trees. The workers smiled at 

them and explained that this particular bark they were extracting was simply cork, the material that 

is used as bottle stoppers.  

Isabel then remembered of pictures from her parents when they visited the Portugal Pavilion at Expo 

2000 in Hannover (Figure A), whose walls were made of cork! They were really curious and decided 

they wanted to learn more about this fantastic oak tree, the cork that it produces and its possible 

applications. 

 

Figure A – Portugal Pavilion at Expo 2000 Hannover. 

Álvaro Siza Vieira and Eduardo Souto Moura, Pritzker Prize winners, Portuguese architects, used pure 

expanded cork boards and high density cork boards as external coating on some facades of the 

building.  
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In this task you will get to know a little more about cork and, hopefully, you will understand why it 

is considered an extraordinary natural product. 

With this aim, you will show Vasco and Isabel how to identify the best cork-producing tree that will 

allow making premium wine bottle stoppers. You will also show them how to evaluate the quality 

of a cork stopper and will demonstrate that cork can really be an efficient thermal insulator. 

 

This assignment includes 4 individual tasks which consist on: 

 

Task 1 - 1 – Identification of Key Characteristics of Cork and of the Cork Producing Tree  60 Marks 
 

Task 1 - 2 – Selection of the Perfect Cork Plank to make Premium Wine Bottle Stoppers    60 Marks 
 

Task 1 - 3 – Determination of Phenolic Content and Evaluation of Cork Quality.               120 Marks 
 

Task 1 - 4 – Cork as Thermal Insulator                                                                                 120 Marks 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



EUSO 2019 Seite 11 

 

 

TASK 1 - 1.: IDENTIFICATION OF KEY CHARACTERISTICS OF CORK AND OF THE CORK 

PRODUCING TREE  

Introduction 

There are approximately 200 species listed under the genus Quercus, but only one species has the 

ability to continuously produce a structure with technological characteristics that make it highly 

valuable. This structure is commonly called cork and it is a protective structure named phellem by 

plant anatomists. 

Cork is evaluated according to its quality, with two main physical-chemical factors being evaluated: 

plank thickness and plank porosity. Plank thickness relates with cork annual growth, i.e. the number 

of cells produced per year. Currently, the cork production cycle takes 9 years, the annual rings being 

visible in the planks (Figure 1 - 1.1). Cork planks are classified according to its thickness and are 

normalised into calliper classes. However, there is not a direct relationship between thickness and 

quality.  Very thin planks are not suitable for industry purposes while thick planks have too much 

gas permeability (negative trait for cork quality). If cork is used for stopper production and there are 

too much permeability, it will allow too much air to diffuse it may damage the wine. Additionally, 

if the plank is too thick, too much unused cork is waste in the production line. When having a 

suitable plank thickness, the plank is evaluated for its porosity. 

 

Figure 1 - 1.1 – Schematic representation of a cross-sectoral plan of a cork oak plank. The phellogen 

produces cork layers that develop radially with an annual physiological rhythm; nine annual growth 

rings are represented here (1, most recent; 9, older one). Cork bark (10) is exposed to the atmosphere. 

The phellogen (11) is in contact with the most recent growth ring (1). 

So, cork quality is the result of the individual genetic makeup and growth conditions, both abiotic 

(e.g. water availability) and biotic (e.g. pathogens that comprise tree growth or that compromise 

cork homogeneity). 

Within this task you are asked to identify the cork producing tree (task 1 - 1) and to identify key 

characteristics of cork quality (task 1 - 2). 
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Materials and equipment 

● Five Petri dishes with plant material (A - E), one per specimen (each individual represents 

one species) containing: 

o Leaves, fruits  

o Small Petri dish with branches ultrathin cuts (for Sudan red staining) 

● Cork micro slices for positive control for Sudan red staining (labelled as “+”) 

● Photographs of the branches, fruits, leaves and trees for each species (A - E) 

● Appendix 1  “Morphological characteristics of the biological material” 

● Microscope glass slides, 1 box 

● Glass coverslips,1 box 

● Tweezers, 1 piece 

● 20 μL Micropipette, 1 piece 

● 20 μL Micropipette tips, 1 box 

● Deionized water in 10 mL test tube, 1 piece (labelled as “H2O”) 

● Sudan red reagent in 10 mL test tube, 1 piece (labelled as “Sudan Red”) 

● Ethanol 70% in 10 mL test tube, 1 piece (labelled as “EtOH”) 

● Pasteur pipettes, 3 pieces 

● 24 well plate, 1 piece 

● 500 mL plastic beaker for waste, 2 pieces   

● Timer also to be used in Task I.3, 1 piece  

● Optical microscope, 1 piece  

● Stereomicroscope - shared (one per two working groups) 

If you spill a chemical or break a piece of glassware or destroy the biological material and you 

need a replacement, request the help of  the lab assistant.  

Any additional material from the list above mentioned  will cost you 5 marks unless otherwise 

stated. You can only ask for one additional Petri dish with plant material and this will cost 

you 10 marks.  
 

1 - 1.1. Identification of the cork producing tree  

In your workstation you will find 5 Petri dishes with biological samples – named A, B, C, D and  E 

- from five different trees, one of them is the cork producing tree. Please be very careful when 

handling the thin sections. 

In this task you are asked to identify the 5 species to which each specimen belongs to, following a 

set of experimental activities.  

Fill in the following table that will lead you to the characterization and identification of the 5 trees 

(A, B, C, D and E). For that you will need to use the biological samples in the plate, the photos and 

the Appendix 1 provided. 

When filling in the table, indicate with a cross (X) the characteristics that best fit your observations 

and/or experimental results. It may be the case that  there is  more than one correct option for each 

specimen. Be sure to clearly indicate all that apply. 
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If you select incorrect options, this will cost you 20% of the marks per option. 

If you  do  not  select all the options that apply, this will cost you 10% of the marks per option. 

1 - 1.1.1. Instructions for the experimental procedure 

Read the table carefully before you start your observations.  

To avoid multiple observations of the same material (getting in and out of the plate), observe 

all the characteristics under the optical microscope or stereomicroscope that are asked to fill 

the table. 

 

Observation of the biological material provided AND photographic handout; 

1. Leaf trichomes (“hairs”) observation under the optical microscope (magnification 100X): just 

put the leaf on the top of a microscope slide - use the whole leaf (not a fragment); do not 

use water nor a cover slip -  turn on the microscope and observe at lower magnification. 

Observe both sides of the leaf (upper and lower). Observe all the leaves available, and within 

each leaf observe multiple areas. 

2. Water droplet test: select one leaf and use a micropipette to measure a drop of 10 µL of water. 

Gently apply, without pressing, the drop on each of the surfaces of the leaf (upper and lower). 

Apply at least 10 drops per leaf surface, in differents parts of the same leaf. Be sure to apply 

one drop on the middle vein and another drop on a surface that is not in contact with the middle 

vein.   

3. Observe the water droplet under the stereomicroscope to determine its shape. 

4. When analysing the lower surface, and after the droplet test, lean the leaf at 90° and check if 

the drop slips or changes shape. Answer the question based on the behavior of at least 6 out of 

10 drops. 

5. Dry the droplets with paper and return the biological material to the respective Petri 

dishes. 

6. Sudan Red test: Use the 24 wells plate to stain the young stems slices. Use three wells per 

species. Pipette 0.5 ml of Sudan Red stain, 0.5 ml of 70% ethanol or 0.5 ml of water per well 

(as suggested in the figure below). You can find all these reagents in tubes of 10 ml and with 

the correct label. Use the provided tweezers to pick the cuts and pass them through the solutions. 

Insert the slices in the 70% ethanol solution for 1-2 min, then insert them in the Sudan Red solution 

and incubate for 10 min; take the slices off and wash them in the previous 70% ethanol solution (1-

2 min); pass the slices through distilled water (1-2 min) and mount them in a slide, with a drop of 

water and a coverslip. 

Observe the preparation under the microscope. Look at several different pieces. In addition to the 5 

tree samples, you also need to stain the positive control. 
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Proposed layout: 

Wells A1 to A6 – use for the 70% ethanol solution;  

Wells B1 to B6 – use for Sudan Red solution;  

Wells C1 to C6 – use for water; 

Wells  D1 to D6   remain empty. 

Use wells A1 to C1 for specimen A,  

A2 to C2 for specimen B, and so on.  

Use wells A6 to C6 for the positive control.  

Read the Table and optimize the use of the microscope and 

stereo microscope.  

The swap of biological material between Petri dishes will cost you 20 marks.  

❖ Enter the biological material dataset ID number in the answer sheet. 

Question 1.1.a 

Following the instructions provided, fill Table 1.1.a in the answer sheet: 

❖ Enter your results under Question 1.1a. in the answer sheet. 

Question 1.1.b 
On completing your observations, use the dichotomous key provided in the answer sheet  to identify 

the species present in each Petri dish. On the answer sheet, in Table 1.1.b, make a correspondence 

between the Petri dish letter and the name of the tree 

❖ Enter your results under Question 1.1.b  in the answer sheet. 

Question 1.1.c 
In trees, in which leaf surface would you expect to find stomata? 

❖ Enter your answer under Question 1.1.c in the answer sheet. 

Question 1.1.d  
In trees, what is the advantage of  highly pubescent leaves? 

❖ Enter your  answer under Question 1.1.d in the answer sheet. 

Question 1.1.e 
If you are asked to determine if these trees are monocotyledonous or dicotyledonous, which plant 

organ would you use? 

❖ Enter your answer under Question 1.1.e in the answer sheet. 

Question 1.1.f 
You were asked to perform the Sudan Red staining in young stems of the several specimens. You 

probably notice a dark layer in the most external part of the sections. Can you provide the most 

probable function of this layer? 

❖ Enter your answer under Question 1.1.f in the answer sheet.  
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TASK 1 - 2.: SELECTION OF THE PERFECT CORK PLANK TO MAKE PREMIUM WINE 

BOTTLE STOPPERS  

Introduction 

Now that you have succeed to identify which sample belongs to a tree of Quercus suber, commonly 

known as the cork oak, we need your help in determining which sample of cork planks should be 

used for wine bottle stoppers.  

Cork planks from three different trees, which represent three different types of cork, were collected 

for your analysis (Figure 1 - 2.1). Please take some moments to analyse the texture, the porosity and 

imperfections present in your cork samples. Cork planks enriched in lesions, or with the 

inappropriate width, are not suitable for making wine bottle stoppers.  

 

Figure 1 - 2.1 – Images obtained from the lateral area of each plank are shown below (labeled A to C). 

 

It is possible to observe the environmental effects on each particular tree. Cork cells do not grow on 

Winter, they only grow in Spring and Summer. The growth rate depends on the physiological 

conditions of the tree and the amount of water available. During Spring, you may observe more cell 

divisions, which result in larger cells with thinner cell walls. During Summer there are fewer cell 

divisions, which result in cells with cell walls differently assembled (tougher and darker). 

The environmental conditions are reflected in each tree growth rings and the analysis of the width 

of the tree rings can give you further information about the growing conditions, namely climate 

effects, insect attacks, fire and light availability. 

In this task, you need to determine the average fraction of the cork material with imperfections of 3 

cork planks shown in Figure 1 - 2.1 (one sample of each cork plank is available in the laboratory in 

case you want to briefly observe these imperfections). The sample with a suitable thickness and 

lowest fraction of imperfections should be the best for bottle stoppers production. 

Materials and equipment 

● Computer, 1 piece. 
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● Cork sets for hands-on observation of cork - shared. One cork set with 3 samples is available 

per Laboratory. 

1 - 2.1. Cork plank quality control: quantification of 

imperfections  

Follow the procedure described below: 

1. Open the programs ImageJ and OpenOffice, by clicking twice in their respective symbols that 

are available on the Desktop. In OpenOffice, chose the option Spreadsheet. 

2. In ImageJ, open files named A to C (command File>Open) that are on the Desktop (Folder 

Images_EUSO). These image files have been taken with a digital scanner and saved in RGB 

color format.  

3. Extract the information in each channel by applying the command Image>Color>Split 

Channels. This command will extract the information in the Red, Green and Blue Channels into 

three different images. 

4. To each image apply the command Image>Lookup Tables>Grays (to change the color of each 

frame to Gray). Then apply the command Image>Adjust>Brightness/Contrast (to adjust the 

intensity of the pixels in each image) and choose the option Auto. Finally choose the option 

File>Save As>Tiff (to save each image in a TIFF format). Alter the name of each image to 

any chosen designation that clearly identifies the colour. 

5. For each plank (samples A to C) you get three images. For each sample, decide which image to 

use in the next steps. 

Question 2.1.a 

Which channel(s) allows you the best observation of the growth rings?  

❖ Enter your results under Question 2.1.a in the answer sheet. 

6. After choosing the image you want to analyze, save it with a different name such as “Image_1 

- tif”. Then open the image with the command File>Open and choose the button in the toolbar 

that corresponds to the Rectangle Selection (1st button from the left side). Select the area of the 

cork you want to analyze. Do not include the black background.  

7. Copy the information inside the selection by choosing the command Edit>Copy to System. 

8. Choose the option File>New>System Clipboard. This step will paste the information that you 

have copied into a new RGB file. 

9. Choose the option Image>Type>8-bit to convert the file from a RGB Color format into a 8-bit 

format. 

10. Choose the option File>Save As>Tiff (to save the selected region in a TIFF format). Save as 

Image_A_crop_1.tif. 

11. Choose the option Image>Adjust Threshold and define the intensities of the pixels in the 

“Threshold” window in order to include the dark areas you want to quantify. If you are happy 

with the selected regions choose “Apply”. The selected regions will be colored with white and 

a pixel intensity of 255. The other regions will be colored with black and a pixel intensity of 0. 
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12. Choose the option Analyze>Set Measurements and define what you want to measure and the 

number of decimal places. 

13. Choose the option Analyze>Measure and record the values obtained in the window “Results”. 

This is the area of the entire image you have in pixels2 (pixel x pixel). 

14. Close the window “Results”. 

15. In order to save an image with the area with white pixels, use the option File>Save As>Tiff. 

Save as Image_A_crop_1 _threshold.tif 

16. Choose the option Analyze>Analyze Particles and decide which parameters you will need. We 

propose that you choose the option “Outlines” in “Show:” (to observe the regions that have 

been selected) and that you click the option “Display Results” and “Add to Manager” (to save 

the results in a file that you can open using the OpenOffice spreadsheet also available on the 

Desktop). Then click “OK”. 

17. You will be able to select each assembled Region of Interest (ROI) in the window “ROI 

Manager” and see where it is in the window with your image. Select all the ROI and save the 

file in the same folder you have been saving all your ImageJ files. The values of the area for 

each ROI are shown in the window “Results” in pixels2. 

Do not forget to organize and save your files so that it is possible to confirm that you have 

executed correctly the proposed protocol. This information will be considered in the 

classification of questions 2.1.b to 2.1.e. 

Question 2.1.b 

How many files have you produced with the protocol you followed to determine the percentage of 

area with imperfections in the cork samples A to C? Please include the files you have produced with 

the spreadsheet based software that is available in your computer. 

❖ Enter your results under Question 2.1.b in the answer sheet. 

Question 2.1.c 

Which region of the cork samples A to C have you considered in the determination of the percentage 

of area with imperfections? Draw with waterproof marker the region you considered in the answer 

sheet. 

❖ Enter your results under Question 2.1.c in the answer sheet. 

Question 2.1.d 

Determine the percentage of area with imperfections in the different cork samples A to C. Which of 

the samples has the lowest percentage of area with imperfections? You will need to use the 

OpenOffice spreadsheet available in your computer. 

❖ Enter your results under Question 2.1.d in the answer sheet. 
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Question 2.1.e 

Take in consideration the area with imperfections, draw a bar plot with the percentages of the dark 

regions present in the 3 cork planks. You should use the values measured in the previous question. 

❖ Enter your results under Question 2.1.e in the answer sheet. 

Question 2.1.f 

How many growth rings can you easily observe in the plank A? 

❖ Enter your answer under Question 2.1.f in the answer sheet. 

 

Consider Figure 1 - 2.2 for the next questions, where you may detect 10 different layers that 

correspond to 10 consecutive growing years. 
 

 

 

 

 

 

 

 

 

 

Figure 1 - 2.2 – Image of the lateral area of one of the planks that you have analyzed. Numbers represent 

annual growth rings. 

Question 2.1.g 

Why do you think there are darker and lighter areas within the growth rings? Choose the best 

hypothesis. 

❖ Enter your answer under Question 2.1.g in the answer sheet. 

Question 2.1.h 

In which year do you think it rained more? 

❖ Enter your answer under Question 2.1.h in the answer sheet. 

Question 2.1.i 

Indicate which regions do you think correspond to Spring and Summer growth. 

❖ Enter your answer under Question 2.1.i in the answer sheet. 

Question 2.1.j 

Which layer/growth ring has been exposed to the atmosphere? 

❖ Enter your answer under Question 2.1.j in the answer sheet. 

 

 
TASK 1 - 3.: DETERMINATION OF TOTAL PHENOLIC CONTENT AND EVALUATION OF 
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CORK QUALITY 

Introduction 

Due to its unique physical and chemical characteristics, cork is an excellent seal for table wines, 

sparkling wines and liqueurs among others. As seen in the previous task (1 - 2), not all types of cork 

can be used in the manufacture of wine bottle stoppers. 

Cork planks with too much permeability, or with the inappropriate thickness, are not suitable for 

making wine bottle stoppers. This is because cork aromas can have an effect on the sense of smell 

and taste of wine.  

The complexity of cork aromas is sometimes associated with the appearance of sensory defects in 

wine. This may arise as a consequence of the presence of exogenous chemicals of microbiological 

origin. Although the percentage of appearance of aroma defects associated with the use of cork 

stoppers is very low, producers of cork stoppers have been making efforts to apply appropriate 

quality control methods. Among these, in the cork stoppers sensorial analysis it is important to 

evaluate the presence of 2,4,6-trichloroanisole (TCA), that cause the mould smell/taste in wine.  

The formation of TCA occurs when microorganisms, such as fungi, come into contact with chlorine-

based compounds, usually chlorophenols, as represented in Figure 1 - 3.1 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1 - 3.1 – 

Production pathway of 2,4,6-trichloroanisole (TCA).  

1 - Lignin; 2 - Phenol; 3 - 2,4,6-Trichlorophenol (TCP); 4 - 2,4,6-Trichloroanisole (TCA); A - 

Fungi;  B - Filamentous fungi biomethylation 

 

Since phenol is itself a product of degradation of the polymeric structure of cork, the quantitative 

determination of phenol present in cork is an important parameter to determine, not only its quality, 

but essentially its possible applications. 

In this task you will determine the amount of phenol present in cork samples and thus classify cork 

in terms of its quality to be used in the production of cork stoppers. 

Phenolic quantification assay is based on Folin-Ciocalteu (Folin) reagent. The Folin reagent contains 

phosphomolybdic/phosphotungstic acid complexes. The method relies on the transfer of electrons 

in alkaline solution from phenolic compounds to form a blue chromophore constituted by a 

phosphomolybdenum/phosphotungsten complex. Its colour intensity depends on the concentration 

of phenolic compounds. The reduced Folin reagent is detectable with a spectrophotometer in the 

range of 600 to 710 nm. 
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In the quantitative analysis of phenols, the Lambert-Beer law will be used. It relates the 

concentration of a compound with its absorbance.  

A = εbC 

This law predicts a linear relation between the absorbance reading (A) and the molar concentration 

of the compound (C), if (b), the cell or cuvette width, is kept constant. ε is a constant defined as the 

absorptivity and is characteristic of the compound and solvent media. Thus, it is possible to 

determine the concentration (mg.L-1 or mol.L-1) of a given compound in a solution through the 

absorbance of that solution if the cell length (cm) and the absorptivity (L.mg-1.cm-1 or L.mol-1.cm-1) 

are known. 

Materials and equipment 

● Volumetric flask, 50 mL, 10 pieces 

● Graduated beakers, 25 mL, 15 pieces  

● Volumetric pipette 3.00 mL, 2 pieces 

● Volumetric pipette 5.00 mL, 1 piece 

● Volumetric pipette 10.00 mL, 1 piece 

● Volumetric pipette 20.00 mL, 1 piece 

● Volumetric pipette 25.00 mL, 1 piece 

● Pipette filler bulb, 1 piece  (general tray) 

● 1000 μL micropipette, 1 piece   

● 1000 μL micropipette tips, 1 box   

● Disposable plastic Pasteur pipettes, 3 pieces 

● 1 cm length/2 mL plastic cuvettes, 5 pieces 

● 500 mL plastic beaker for waste, 2 pieces 

● Waterproof marker, 1 piece 

● Deionized water in 500 mL plastic wash bottle, 2 pieces (labelled as “H2O”) (can be refilled 

if needed without penalty) 

● Stock solution of gallic acid (0.00050 mol.L-1), 100 mL (labelled as “Gallic Acid”) 

● Stock solution of Folin-Ciocalteu, 20 mL (labelled as “Folin”) 

● Stock solution of sodium carbonate (7.5% w/w) , 20 mL (labelled as “Na2CO3”) 

● Three samples of cork extracts (labelled as “Lot A”; “Lot B”; “Lot C”), 2 mL each 

● Colorimeter, 1 piece 

● TI-Nspire CX calculator, 1 piece 

● Scientific calculator TI-30X, 1 piece (general tray) 

● Timer also to be used in Task 1 - 1, 1 piece (general tray) 

 

If you spill a chemical or break a piece of glassware and you need a replacement, please request  

the help of the lab assistant.  

Any additional above mentioned material will cost you 5 marks unless otherwise stated. 

Additional samples will cost you 10 marks.  
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1 - 3.1. Calibration curve slope (m) 

The first task is to determine the term εb from the Lambert-Beer law, that is the slope m, using a set 

of solutions of known concentrations (standard solutions) that will be prepared from a stock solution 

of gallic acid (5.0x10-4 mol.L-1). Gallic acid is traditionally used to determine the Total Phenolic 

Content (TPC) in various materials. 

 

Figure 1 - 3.2 – Chemical structure of Gallic Acid (GA) 

Prepare 50 mL of each standard solution using the volumes indicated in the Table 3.1 by using the 

pipette filler bulb (see in Appendix 2) and the appropriate pipette. 

Table 3.1 

Standard solutions prepared from the stock solution 
 

Standard 
Stock solution 0.00050 mol.L-1 

Volume to add in mL 

S1 3.00 

S2 5.00 

S3 10.00 

S4 20.00 

S5 25.00 

 

Question 3.1.1. 

Calculate the concentration of the standard solutions prepared by you (in mg.L-1). Indicate the 

obtained value with 2 decimal places. 

❖ Enter your calculations and results in the answer sheet, under Question 3.1.1 in the 

Table. 
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1 - 3.1.1. Samples for calibration curve 

1. Using the micropipette carefully transfer 500 μL of each standard solution into a 25 mL beaker 

and add to each 500 μL of the Folin reagent, stir, wait 3 minutes and then add to each 500 μL 

of the Na2CO3 solution. 

2. Prepare the blank solution following the instructions in point 1. but using 500 μL of H2O instead 

of the standard solution. 

3. Stir  all prepared solutions and leave them to stand for 30 minutes.  

4. Connect, wait approximately 5 minutes and calibrate the colorimeter (see instructions for 

Vernier Colorimeter in Appendix 3).  

5. After points 3. and 4. read  the absorbance of the solutions at the wavelength of 635 nm using 

the colorimeter. Indicate the obtained value with  2 decimal places. 

Question 3.1.2. 

❖ Record the values in the Table of the answer sheet under Question 3.1.2. 

Question 3.1.3. 

Plot the absorbance (A) versus the gallic acid concentration (Cgallic acid). 

❖ Register only the experimental points in millimeter paper under Question 3.1.3 in the 

answer sheet. 

Question 3.1.4. 

From the A and Cgallic acid data determine the slope of the straight line that best fits the experimental 

data points.  

The straight line that best fits the experimental data points can be determined by the least squares 

fitting method. The least squares fitting method is based on the minimization of a function that 

computes the sum of the squares of the differences between the expected values of A and its 

corresponding experimental values.  

To do this, start by calculating the sums according to the following example Table. 

Example of the calculations for the determination of the slope using the least squares 

fitting method. 
 

(xi)2 xi x yi 

x1
2 x1 x y1 

…. …. 

x5
2 x5 x y5 

Sx2 = Sum of (xi)
2  Sxy = Sum of (xi x yi)  
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Calculate m as follows: 

          

❖ Fill the Table in Question 3.1.4 in the answer sheet with the sums you need to 

calculate the slope  

❖ Enter your calculations and results of m under Question 3.1.4 in the answer sheet 

❖ Record the value of the absorptivity of gallic acid  

In the plot A versus Cgallic acid and using the calculated value for   m   draw the straight line that best 

fits the experimental points.  

❖ Use the Plot of Question 3.1.3 in millimeter paper in the answer sheet to draw the 

straight line. 

1 - 3.2. Limit of Detection – LOD 

The limit of detection, LOD, is a very important parameter that determines the degree of confidence 

with which a given concentration can be measured. When studying samples of concentration below 

the detection limit of a technique, it is usually necessary to add a sample concentration step. 

For any given technique the LOD can be calculated as 3 times the maximum standard deviation (σ) 

of the measurement divided by the slope of the calibration plot according to IUPAC (International 

Union of Pure and Applied Chemistry). 

LOD = 3σ / slope 

Any signal measured in the real world has an associated uncertainty, that is a fluctuation around an 

average value, that affects the precision of the measurement. For instance, if a solution of a given 

concentration is prepared several times by weighing the same amount of compound and dissolving 

it in the same amount of solvent, different final concentrations will be obtained.  

The standard deviation is related with the distance between the measured values and the average 

value of the measurements and is affected by the uncertainty that is involved in the preparation and 

in the measurement. 

Determine the uncertainty in the measurements of the absorbance at 635 nm by preparing 5 

replicates of the standard solution 1. For each one: 
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1. Measure 500 μL of each standard solution into a 25 mL beaker and add 500 μL of Folin reagent, 

stir, wait 3 minutes and then add 0.5 mL of Na2CO3. 

2. Prepare a blank following the instructions in point 1. but using 500 μL of H2O instead of the 

sample. 

3. Stir and leave to stand for 30 minutes.  

4. Calibrate the colorimeter with the blank (see instructions for Vernier Colorimeter in Appendix 

3).  

5. After this period determine the absorbance of the 5 solutions at 635 nm using the colorimeter. 

Indicate the obtained value with 2 decimal places. 

❖ Record the value in the Table in the answer sheet under Question 3.2.1 

In statistics, the standard deviation (σ) is a measure that is used to quantify the amount 

of variation or dispersion of a set of data values. A low standard deviation indicates that 

the data points tend to be close to the mean (also called the expected value) of the set, 

while a high standard deviation indicates that the data points are spread out over a 

wider range of values. 

For a finite set of numbers, the standard deviation is obtained  by taking the square root 

of the average of the squared deviations of the values from their average value. 

For example, if we have obtained the values 2; 4; 4; 4; 5; 5; 7; 9 from 8 successive 

measurements, the average of the measurements is 5. 

First, calculate the deviations of each data point from the mean, and square the result 

of each, to obtain the squared deviations: 

(2-5)2=9 

(4-5)2=1 

(4-5)2=1 

(4-5)2=1 

(5-5)2=0 

(5-5)2=0 

(7-5)2=4 

(9-5)2=16 

Calculate the mean of these values (called variance) and you will obtain 4. The standard 

variation is the square root of the variance σ = 2 
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Question 3.2.2. 

From the standard deviation and the slope you should determine the LOD of the total gallic acid 

content. 

❖ Enter your calculations and results in the answer sheet, under Question 3.2.2  

1 - 3.3. Cork extracts analysis and evaluation 

The  cork planks A, B, C, from previous task 1 - 2,  were subjected to an extraction procedure and 

the obtained extract was concentrated 10 times and stored at -20 °C to ensure its conservation. Three 

samples of cork extracts (Lot A; Lot B; Lot C) are supplied to be analysed. 

1. Carefully transfer 500 μL of the "Lot A" sample into  a 20 mL beaker and add 500 μL of Folin-

Ciocalteu reagent, stir, wait 3 minutes and then add 500 μL of Na2CO3. Stir and leave to stand 

for 30 minutes.  

2. Repeat point 1. for each of the "Lot B" and "Lot C" samples.  

3. Prepare a blank following the instructions in point 1. but using 0.5 mL of H2O instead of the 

sample. 

4. After this period of 30 minutes determine the absorbance at 635 nm and record the value in the 

Table under Question 3.3.1.. 

❖ Record the value in the Table in the answer sheet, under Question 3.3.1. 

Question 3.3.2. 

Determine the total phenolic content present in the cork samples provided and register the values in 

the answer sheets. 

❖ Enter your calculations and record the value in the Table under Question 3.3.2 in 

the answer sheet. 

Question 3.3.3. 

Is the detection limit of the method adequate to ensure direct measurement of the samples (i.e., 

without a concentration step)? 

❖ Answer under Question 3.3.3 in the answer sheet. 

Question 3.3.4. 

Considering the provided information and the data gathered by your team in task 1 - 2 and 1 - 3, 

which plank would you choose as suitable for premium stoppers production? 

❖ Answer under Question 3.3.4 in the answer sheet. 

 
 

 
TASK 1 - 4.: CORK AS A THERMAL INSULATOR  
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Introduction  

In this task you will explore another important characteristic of cork and its application in building 

construction. 

The ability of a material to conduct heat is called the thermal conductivity. The air which fills the 

cork’s cellular structure makes it an excellent thermal insulator. As it provides a high level of 

thermal insulation, cork finds many uses, including in the building and aerospace industries. As an 

excellent thermal insulator, cork has a very low thermal conductivity. 

Thermal conductivity 

Heat is the energy transferred due to temperature difference (the energy is transferred from the 

higher to the lower temperatures). Heat transfer can occur via different mechanisms, namely 

conduction, convection and radiation. Conduction is a mechanism of heat transfer (or heat flow) 

within a body or between bodies in contact, that results from the transfer of kinetic energy through 

collisions taking place at a microscopic level. When a very small1 quantity of heat, or thermal 

energy, dQ is transferred in a very small2 time interval dt, the heat flow, also called heat current, 

is defined as: H = dQ/dt. The heat current through an body (see Figure 1 - 4.1) of length 𝑙 (along the 

direction of the heat flow) and uniform cross-sectional area 𝐴, when the temperature difference 

between its two ends is T1 - T2 (T1  and T2 are the higher and lower temperatures, respectively), is 

governed by the law: 

 

where 𝑘 is a positive constant, which is a function of the constituting materials of that body, called 

thermal conductivity. As for the ratio  (T1 - T2) / l it is the temperature difference per unit of length. 

 

Figure 1 - 4.1 – Heat conduction through a bar of length l and cross sectional area 𝐴, placed between 

two bodies that are at temperatures T1 and T2, respectively. The temperature difference between the 

two sides of the bar causes a heat flow from the higher temperature side to the lower temperature 

side, as represented by the arrow.  

The goal of this task is to determine the thermal conductivity of a thin sample of cork, by using the 

Lee’s disc method, described under 1 - 4.1. 

Warnings:  

Do not touch the hot steam generator. Never direct the steam stream towards you or your 

colleagues. Use the forceps whenever you have to move the hot steam chamber. Use the pot 

holder whenever you have to touch materials at high temperatures (steam generator; Lee’s 

disc and rubber tubes). 

                                                      
1 dx denotes a very small amount of the quantity x.  
2 Note that, in general, the heat flow varies with time. Thus, to calculate an instantaneous measure of heat current, 

H(t), a very small time interval around t should be used. 
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Materials and equipment (Figure 1 - 4.2) 

● Steam generator (A) with a control slider (cs) 

● Steam chamber (B) 

● Brass disc (Lee’s disc) (C) 

● Acrylic stand for Lee’s disc and steam chamber (D) 

● A thin cork sample (E) 

● Forceps (F) 

● 2 calibrated temperature probes (thermistors) (G), to be connected to a TI-Nspire CX 

calculator, through a data logging Lab Cradle interface 

● Texas Instruments TI-Nspire CX calculator with a data logging Lab Cradle interface (H) 

● Thermal paste (to improve the thermal contact with the temperature probes) (labelled “Heat 

Sink Compound Plus”) (I)  

● A thick cork insulator block (J) 

● A large cork insulating base (K) 

● Rubber tubes (L) 

● Pot holder (M) 

 

Figure 1 - 4.2 – General experimental materials and equipment. 

The method comprises two parts using two different experimental setups. 
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1 - 4.1. Part 1 of Lee’s Disc Method 

Figure 1 - 4.3 illustrates the first of two experimental setups that you will use to measure the thermal 

conductivity of a cork sample, using the Lee’s disk method. The cork sample (CK) is disc-shaped. 

You will place it between the cylindrical steam chamber (SC), and a brass disc – the Lee’s disc (LD) 

– which are mounted on an acrylic stand base.  

 

Figure 1 - 4.3 – Experimental setup for the first part of the Lee’s disc method for determining the 

thermal conductivity of a cork sample. On the left is shown the apparatus itself, whereas in the right 

is illustrated, schematically, how data is collected. SC – Steam Chamber; CK – Cork Sample; LD 

– Lee’s Disc; BB - Brass Base; TSC – Temperature of the base of the steam chamber; TLD – 

Temperature of the base of the Lee’s Disc; I - Steam in; O - Steam out; d - sample thickness. 

   

When the steam generator, connected to the steam chamber, is turned on, the chamber heats up. The 

temperature, TSC, at the base of the steam chamber, just above the cork sample, can be measured by 

one of the thermistor (T-SC). A heat current, Hin, flows from the chamber to the Lee’s disc through 

the cork sample, increasing the temperature of the Lee’s disc. The second thermistor (T-LD), 

measures the temperature of the Lee’s disc, TLD, which is in contact with the bottom surface of the 

cork sample. When TLD increases above room temperature, heat also flows (through conduction, 

convection and radiation) from the Lee’s disc to the environment. Thus, a heat current, Hout, leaves 

the Lee’s disc. As  TLD increases, Hin decreases and Hout increases. When Hin = Hout a steady state is 

reached, and TSC and TLD remain constant at the values TH and TL, respectively.  
 
Procedure 

1. Consider the following data: the mass of the Lee’s disc, m = 629 g; height of the Lee’s disc, ℎ = 

1.5 cm; diameter of the Lee’s disc, 𝐷 = 8.0 cm and the thickness of the cork sample, 𝑑 = 2.1 

mm. Put this data in the answer sheet.  

❖ Enter the data (in SI units) in the Table under Question 4.1.1. in the answer sheet. 

2. Insert one of the temperature probes (T-SC) into the hole in the base of the steam chamber, and 

the other (T-LD) into the hole in the Lee’s disc. To ensure a good thermal contact with the 

temperature probes, you should smear the tip of each probe with thermal paste, prior to inserting 

the thermistors in each hole. 
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3. Connect the two temperature probes to the Lab Cradle data logging interface – to see how to do 

this and how to operate with the TI-Nspire CX calculator software see Appendix 3. Start to 

monitor the temperatures TSC and TLD using the TI-Nspire CX calculator (monitoring mode).  

4. The pan of the steam generator is already half filled with water and ready to operate. Do not 

remove the hose or the retaining clamp. Connect the flexible tube from the steam generator to 

the inlet of the steam chamber (located close to its top). Connect the steam outlet (located close 

to the base of the steam chamber) to the nearest lab sink. Connect the hot plate of the steam 

generator to the power supply and set the heating level to “3.5-4” using the control slider. If there 

is any problem with the steam generation, please call a lab assistant.  You will not be penalised 

for this. 

5. Put the steam chamber in contact with the Lee’s disc. Turn on the steam generator and preheat 

the disc to the temperature, T, of 60ºC. This procedure is very fast. Do not exceed T= 65ºC. Use 

the forceps to hold tight the chamber, remove it from the acrylic stand and put it on top of the 

large cork insulating base (K in Figure 1 - 4.2). If the temperature exceeds 65oC, wait until it 

cools back to that value, before proceeding to the next step.  

6. Place the cork sample on the top of the Lee’s disc. Put the steam chamber, carefully and using 

the forceps, on the top of the cork sample. The cork should appear between the two brass 

components of the setup (see Figure 1 - 4.3). Note that the complete ensemble is now back to 

the acrylic stand. Ensure that the temperature probes remain correctly placed.   

7. Restart monitoring the temperatures TSC and TLD with the TI-Nspire CX calculator. When TSC 

and TLD remain unchanged, record the values TH and TL on the answer sheet. Notice that this 

procedure may take a long time.  

Experiment 1 - 4.1 is finished and you should now turn the control slider to ‘0’ (if you need to 

repeat this experiment call a lab assistant) and disconnect the temperature probe T-SC from the 

data logging Lab Cradle interface. 

❖ Enter your results in Table under Question 4.1.2. in the answer sheet. 

Question 4.1.3 

In the answer sheet write the mathematical expression for the heat current, Hin, flowing into the 

Lee’s disk at the steady state. The expression should be written as a function of k (the thermal 

conductivity of the cork sample) and of the appropriate symbols for other measured quantities.  

❖ Enter your results under Question 4.1.3. in the answer sheet. 

Question 4.1.4. 

In the answer sheet, write the mathematical expression for 𝑎 in  Hin = k a. This expression for a 

should be written as a function of the appropriate symbols for measured quantities. From the 

measured values of those quantities, calculate an experimental value for 𝑎 (give details  of your 

calculations and express the value in appropriate units). 

❖ Enter your results under Question 4.1.4. in the answer sheet. 
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1 - 4.2. Part 2 of Lee’s Disc Method 

The goal of this second part of the experiment is to measure how fast the Lee’s disc cools down, 

i.e., its cooling rate, 𝑟, at the temperature when it reached the steady state. The cooling rate of the 

Lee’s disc is a function of its temperature. When the disc is at a given temperature, 𝑇, its cooling 

rate is the ratio between a small temperature variation dTLD around 𝑇, and the short time interval, 

dt, required for this variation to occur: r(T) = dTLD / dt. At the steady state, the cooling heat current 

from the disc to the environment, Hout, can be related to the cooling rate by the expression:  

 

where m is the mass of the Lee’s disc and c = 377 J / (kg K) is the specific heat capacity of the disk 

material. The specific heat capacity is the heat required to raise the temperature by one degree 

Celsius of 1 kg of the material. 

In the following procedure you will rise the temperature of the Lee’s disc about 5℃ to 10 ℃ above 

TL and then let it cool down, while continuously measuring the temperature of the disc.  The cooling 

down is due to heat flowing from the disc to the environment. 

 

Procedure 

1. Remove the cork sample from the previous setup, using the provided pot holder and the 

forceps as protection.  

2. Set the power of the steam generator to “3.5-4” using the control slider. If there is any problem 

with the steam generation, please call a lab assistant. In this part of the experiment the TI-Nspire 

CX calculator should be used in acquisition mode. Select an appropriate sampling rate. Start 

collecting data from the temperature probe T-LD and wait until  TLD reaches a value about 5 ℃ 

to 10 ℃ above  TL.  

3. Turn the control slider to “0” and disconnect it from the power supply. Using the pot holder as 

protection, withdraw the steam chamber from the top of the Lee’s disc using the forceps and put 

it on top of the large cork insulating base (K in Figure 1 - 4.2). Put the insulation block  J in Fig. 

1- 4.2 on top of the disc and start recording the temperature TLD  over time.  

 

Question 4.2.1. 

Select adequate values from the collected data in order to extract the cooling heat current from the 

disc to the environment at the temperature of the steady state found in Question 4.1.2.   

❖ Enter your results in Table under Question 4.2.1. in the answer sheet. 

Question 4.2.2. 

Plot the data of the Table (Question 4.2.1.) in the provided millimeter paper.  

❖ Plot the data in the provided millimeter paper. 

Question 4.2.3. 

Use your plotted data to evaluate the cooling rate, 𝑟, at the temperature of the steady state found in 

Question 4.1.2. Present your calculations on the answer sheet, indicating which values you have 
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used. 

❖ Enter your calculations and results under Question 4.2.3. in the answer sheet. 

Question 4.2.4. 

In the answer sheet, write the mathematical expression for the thermal conductivity of the cork 

sample, 𝑘, as a function of 𝑚, 𝑐, and any other quantities you got from your experimental data. 

Using that expression, calculate the thermal conductivity of the cork sample, 𝑘.     

❖ Enter your results under Question 4.2.4. in the answer sheet. 

 

1 - 4.3. Housing Thermal Insulation 

Thermal resistance, R, of a slab is a measure of its thermal insulation against heat losses and can be 

defined  as: 

 

where k is thermal conductivity of the material and 𝑙 is the slab’s thickness. In buildings, walls are 

made of different material layers. When the inside and outside wall surfaces are at different 

temperatures, a heat current H will flow through all the wall layers.   

Question 4.3.1. 

Derive a mathematical expression for the total thermal resistance, Rtotal, of a wall with two layers of 

thickness 𝑙1 and 𝑙2, from materials with different thermal conductivities, k1 and k2, respectively, as 

a function of those quantities only.  

❖ Enter your calculations and results under Question 4.3.1. in the answer sheet. 

Question 4.3.2. 

To prevent losses through thermal conduction, a house with walls made of 20 cm thick concrete and 

a 2 cm thick plaster drywall, an insulating layer of 1 cm cork board was added.  Consider that the 

concrete side is facing the exterior of the house at a temperature of 0 ºC and that inside the house 

the temperature is kept at 20 ºC. Calculate the energy wasted by heat conduction during one hour 

through a wall with an area of 50 m2 for the two following cases:  

i) a naked (concrete+plaster, uninsulated) wall;  

ii) an insulated (concrete+plaster+cork) wall.  

Consider the following thermal conductivities (given in the SI units W K-1 m-1): concrete: 1.10; 

plaster: 0.17; cork: use the value found in Question 4.2.4. 

❖ Enter your calculations and results under Question 4.3.2. in the answer sheet. 
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APPENDIX 1  
Morphological observation of the biological material, photos and figures 
1.1. Leaf classification according to their morphology and arrangement. 

          A - Venation           B - Shapes                    C - Arrangement                  D- Margins           E -Arrangement 
on the stem 

 
 
 
 
 
 
 
 
 
 
Figure Legend for Leaf  morphology and arrangement 

A - Venation B - Shapes C - Arrangement D - Margins E - Arrangement on 
the Stem 

1 – Pinnate  4 – Linear 12 - Simple  16 - Entire 20 - Alternate 
2 – Parallel  5 – Oblanceolate 13 – Palmately 

compound 
17 - Dentate 21 - Opposite 

3 – Palmate  6 – Ovate 14 – Pinnately 
compound 

18 - Serrate 22 - Whorled 

   7 – Pinnatipartite 15 – Bipinnately 
compound 

19 - Lobed  

   8 – Palmately lobed    
   9 – Oblong    
 10 – Lanceolate    
 11 – Sagittate    

 
 
 
 
 
 
 
1.2. Trichome classification according to their morphology and arrangement  
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Figure Legend for Trichome classification 

Arrangement Shape 

1 – Pubescent 5 – Glandular  

2 – Pannose 6 – Bifid (2 types) 

3 – Hirsutullous 7 – Stellate (2 types) 

4 – Peltate  8 – Postulate  

 
1.3. Cupule classification according to its morphology. 
 
 
 
 
 
 Figure Legend for cupule classification  
1a, 1b – protruding scales; 2 – fused scales. Flora Iberica 2000. 
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APPENDIX 2  

PIPETTING  

Pipette safety instructions 

● Mouth pipetting is forbidden! 

● Insert the top of the pipette in the bottom of the pipette filler carefully so as not to break the 

glass pipette. 

● Do not allow the liquid to be drawn into the bulb. 

 
 

Pipette filler bulb: (a) Air valve (expels air from the bulb), (b) Suction valve (draws solution 

into the pipette), (c) Empty valve (drains solution from the pipette). 

 

 

 

APPENDIX 3 

Ti-Nspire 
3.1. Collecting data with the data logging Lab Cradle interface connected to a 

calculator with the TI-Nspire CX Software. 
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1. Connect the calculator to the interface 

 
  

1 – Calculator 

2 – Interface 

 

 

 

 

 

 

 

2. Turn on the calculator. 
 

 

1 – Switch On/Off 

 

 

 

 

 

 

 

 

 

 

3.2. Instructions for Vernier 

Colorimeter 

The Vernier Colorimeter is designed to 

determine the concentration of a 

solution by analysing its colour 

intensity. The Colorimeter measures 

the amount of light transmitted through a 

sample at a user-selectable wavelength. 

There are two models: model 1 and model 2. 

 
Using the Colorimeter  

The Colorimeter is easy to use and maintain. Simply connect it to your data collection interface (TI 

graphing calculator), configure your software (Vernier LabPro®), and you are ready to make 

measurements. For best results, let the system stabilize at the desired wavelength for 5 minutes prior 

to calibration or data collection.  
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General procedure to follow when using the Colorimeter  

1. Connect the Colorimeter to the interface in ch1 or ch2 or ch3. 

2. Turn on the TI Nspire 

3. Use the cursor with the Touchpad and press the icon  

 
4. The software will identify the colorimeter and load a default data collection setup.  

 
 

 

 

 

5. Press the “ < ” or  “ > ” button on the Colorimeter to 

select the correct wavelength setting for your 

experiment (430 nm, 470 nm, 565 nm, or 635 nm).  

6. Calibrate the Colorimeter. Note: The Colorimeter needs to be powered about 5 minutes 

before calibrating. One of the four green wavelength indicator lights will be turned on when 

it is powered. 

a. Open the Colorimeter lid.  

b. Insert a cuvette, for your blank cuvette (100% transmittance or 0 

absorbance). Important: Line up one of the clear sides of the 

cuvette with the arrow at the top of the cuvette slot. Close the 

Colorimeter lid.  

c. Next, press the CAL button to begin the calibration process. 

Release the CAL button when the red LED begins to flash. The 

absorbance should now be 0.00 or 0.01.  
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d. When the LED stops flashing, the calibration is complete and your unit is ready to collect 

data.  

7. Collecting data. 

a. Place the cuvette with a sample into the Colorimeter cuvette slot. 

Important: Line up the side of the cuvette with an arrow with 

the arrow at the top of the cuvette slot.  

b. Read the absorbance value 

 

3.3. Instructions for the temperature sensors 

1. Connect the sensor / sensors to interface. Use the first input 

channels.  

 

 

2. The program automatically detects the sensor/sensors. It starts up, by default, in 

monitoring mode, as shown in the following image: 
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3. To move from the monitoring mode to the acquisition mode you have to click on button  

 using the central touchpad. Data will start to be saved.  

4. To adjust the sampling rate and define the acquisition duration, click on  and make the 

appropriated choices.  

 

 

5. The collected data can be visualized in a meter by selecting  , in a plot by selecting  or 

in a table . 

6. If you want to save your data use the popup  above the displaying data window, choose 

File and Save or Save as. 

7. You can read data points in a plot by clicking on the graph to position the cursor at the desired 

point. 
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TASK 2 MARINE RESOURCES 

Introduction 

Currently Portugal has an Exclusive Economic Zone (a sea zone) of 1.7 million km2, the third largest 

in the European Union and the 11th in the world. In August 2017 Portugal began to defend the 

proposed extension of the continental shelf beyond the 200 nautical miles, which can double the 

size of Portugal maritime territory, from the current almost two million to almost four million  km2. 

Given that Continental Portugal has a little more than 92 thousand km2 of area, the extension of the 

maritime territory in another 350 miles will mean that the sea area will be 40 times greater than the 

terrestrial one. 

 

Portugal Exclusive Economic Zone. Continental Portugal 327,667 km2; Azores and Madeira 

Islands (953,633 km2; 446,108 km2). Total: 1,727,408 km2 (picture from Oceana, 

https://eu.oceana.org) 

Why is the maritime territory so important? One answer lies in the richness of marine resources that 

may be available, with a great impact in areas such as energy, biodiversity and biotechnology. That 

was exactly what Vasco and Isabel discovered in their Summer research internship in a Marine 

Research Center in the Lisbon area. During their internship, they went on a expedition to observe 

the installation of an open sea wave generator prototype. Vasco and Isabel became curious about 

the process of generating energy from waves. They also realized the presence of a small ecosystem 

in the vicinity of the wave generator and collected several biological samples to analyze different 

aspects of their biodiversity and possible applications.   

You will show Vasco and Isabel how we can get energy from waves by exploring a point absorber 

wave-generator model. You will also show them how we can explore the marine biodiversity with 

a series of experiments using the biological samples that they collected and still discover a potential 

biotechnological application. 

 

 

 

 

 

https://eu.oceana.org/
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This Task consists of 3 individual subtasks which yield the following: 

 

Task 2 - 1 – Wave-generator         120 Marks 

 

Task 2 - 2 – Marine Ecosystems: Biodiversity and Resources    120 Marks 

 

Task 2 - 3 – Biotechnological Potential of Green and Red Algae.   120 Marks 
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TASK 2 - 1.: WAVE-GENERATOR  
Introduction 

The Marine Centre researchers gave Vasco and Isabel an overview about wave energy. 

 “Winds, blowing over the ocean surface, generate waves. Waves propagate water oscillations to 

vast ocean areas. As a consequence, floating objects at the ocean oscillate up and down and forward 

and backward with water. Waves carry a huge energy. A variety of devices aimed at extracting 

energy from waves are under development. The so called point absorber wave-generator is designed 

to harness energy from vertical oscillations of the water surface in the open ocean. This energy is 

used to drive electromechanical energy converters generating electrical power.” 

 

Figure 2 - 1 – Scheme for a vertical cross-section of a point absorber wave-generator: heaving buoy 

(A), translator (B), magnet (C), stator (D), coil (E). 

Vasco and Isabel would like to better understand how a point absorber wave-generator works! So, 

you are going to help them by performing some experiments. To prepare those experiments, you 

need first to learn the basic physics underlying the process. 

Changes in the magnetic environment of a closed conducting loop can cause a voltage induced in 

the loop and an induced current to flow in the loop – electrical power is generated. This physical 

phenomenon is called electromagnetic induction.  

The magnetic field of a cylindrical bar magnet of neodymium type is very strong close to the magnet 

poles (cylinder bases) and decreases rapidly with the distance. If we move such a magnet up and 

down, in the direction of the cylinder axis, through the surface of a conducting loop, the changes in 

the magnetic environment of the loop will generate some electrical power. A higher power may be 

obtained if the magnet moves quickly through a short coil. With an assembly of coils and magnets 

even more power can be generated! In a point absorber wave-generator there are two main structures 

(see Figure 2 - 1): the tubular stator and the translator. The stator contains a fixed array of coils, 

while a set of permanent magnets move up and down with the translator, through the stator centre, 

as a heavy buoy coupled to the translator top oscillates with the waving of the water surface.   

The point absorber wave-generator model that you are going to assemble will have only one static 

coil and two joined bar magnets driven by the mechanical oscillations of a vertical mass-spring 

system (instead of the vertical water surface oscillations). This model will allow you to show to 

Vasco and Isabel how a point absorber wave-generator operates and the impact of different 

oscillations on the power generated. However, the mechanical oscillations of the mass-spring system 

need first to be analysed. This is the purpose of the first experiment. 
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2 - 1.1. Characterizing the mass-spring system 

The mass-spring system is composed by an elastic spring suspended vertically from its top end and 

by a given mass (𝑀) attached to the spring bottom end (see Figure 2 - 2). The mass is at rest when 

the system is in equilibrium. By stretching the spring vertically, energy is transferred to the system. 

The amount of transferred energy is 

 

where 𝑘 is the spring constant and A is the stretching imposed to the spring (and the deviation of the 

mass from its equilibrium position). When the system is released, the mass starts to oscillate up and 

down. The time interval for motion repetition, i.e. the motion period (𝑇), can be evaluated by 

measuring the time interval between the mass departure from an extreme position and its next return 

to that same position. Since both the suspended mass and the spring oscillate together, 𝑇 depends 

on both their masses. For a given spring of mass (𝑚), the period of elastic oscillations is governed 

by the effective mass parameter, 

 

Materials and equipment 

● Standing structure mounted on a standing base;  

● Pointer pair;  

● Clamp with hook;   

● Spring (𝑚 = (14.0 ±  0.1) 𝑔); 

● A plastic tube with a suspending thread containing a pair of bar magnets, labelled as “M1” 

(M1 = (117.5 ±0.5) g), and a brass mass with two suspending hooks, labelled as “M2” (M2 

= (200.0±0.5) g); 

● Square ruler; 

● Stop watch.  

Figure 2 – 2 – Equipment used in 2 - 1.1: standing structure (A) mounted on a standing base (B), 

pointer par spring (C), clamp with hook (D), spring (E), plastic tube with a suspending thread 

containing a pair of bar magnets (M1), brass mass (M2), stop watch (F) and square ruler (G). 
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Data from this experiment will be presented in Table 1.1 provided on the answer sheet. The data in 

the column labelled as “Set i ” will characterize a given set of experimental conditions. The last 4 

rows of this Table will not be filled during data acquisition. They will be filled when analysing the 

acquired data (Questions 1.1.2 and 1.1.4). 

Question 1.1.1 

The data acquisition for each set of experimental conditions (defined below from 1.1.1a to 1.1.1d) 

should proceed as follows: 

● Attach the mass to the spring suspended vertically from the hook fixed at one of the vertical 

rods of the standing system.  

● Use the pointer pair attached to the vertical rod and the square ruler. Mark the position of the 

mass bottom with the upper pointer and adjust the position of the other pointer to a distance 𝐴 

below. Record the value for the distance between the pointers (𝐴). 

● Stretch down the spring by 𝐴, pulling it vertically down. Then, release the mass-spring system 

(do not apply any push to the system) in order to let it describe free vertical oscillations 

(without lateral deviations). Start the stopwatch to measure the time interval for 10 periods 

(𝑡10). Record the value 𝑡10 in the Table 1.1 on the answer sheet, in the line labelled as (#1) – 

this is the first of 3 measurements of 𝑡10 measured under the same conditions.  

● Repeat the previous procedure two more times to improve statistics. Record the results for 

these assays (#2 and #3) in Table 1.1 on the answer sheet. 

Question 1.1.1a  

Take M1 for the first set of experimental conditions (“Set 1”). Set an amplitude A for the oscillations 

of 3 cm.  

❖ Record the data for “Set 1” in Table 1.1 on the answer sheet. 

Question 1.1.1b  

Keep the mass M1 in the mass-spring system. Set a new amplitude for the oscillations of 2 cm. 

❖ Record the data in the column for “Set 2” in Table 1.1 on the answer sheet. 

Question 1.1.1c  

In your mass-spring system replace M1 with M2. Set an amplitude for the oscillations of 3 cm. 

❖ Record the data in the column for “Set 3” in Table 1.1 on the answer sheet. 

Question 1.1.1d  

Suspend M1 from M2, set an amplitude of 3 cm for the oscillations of this set of masses. 

❖ Record the data in the column for “Set 4” in Table 1.1 on the answer sheet. 

Question 1.1.2  

For each set of experimental conditions calculate: the 𝑡10 mean value of (𝑡10), the oscillations period 
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(𝑇) and the effective mass parameter (𝑀𝑒𝑓).  

❖ Fill the last 3 rows of Table 1.1 on the answer sheet with your results. 

 

Question 1.1.3 

Which of the following relations (where k is a spring constant) best fits your results? 

 

❖ Circle the number of the correct answer in the answer sheet, box 1.1.3.  

Question 1.1.4  

Extract from the different data sets the 𝑘 values in N/m.  

❖ Fill the last row of Table 1.1 on the answer sheet with your results.  

Question 1.1.5  

Calculate the mean value for the spring constant 𝑘.  

❖ Write your result in the answer sheet, box 1.1.5. 

2 - 1.2  Generating an AC voltage 

In this experiment you will assemble your wave-generator model and analyse the influence of the 

amplitude and period of the oscillations on the output voltage (𝑉𝑔𝑒𝑛(𝑡)). This voltage is an AC 

voltage, characterized by a period (𝑇𝑉or time interval for repetition) and by a maximum absolute 

value or voltage amplitude (𝑉0).   

Your spring-mass system is subject to some damping (the amplitude of the oscillatory motion decays 

in time) due to air friction. However, this damping can be neglected in the short time intervals in 

which you will analyse voltages. 

Materials and equipment 

● The setup used in experiment 2 - 1.1; 

● A 6000 turns coil (throughout the work the 6000 winding turns of the coil will be used); 

● Three finger clamp to fix the coil to the standing structure through an universal clamp; 

● Two conducting cables with one banana connector and one alligator connector (banana-

alligator conducting cables); 

● One voltage sensor/probe to be connected to a data logging Lab Cradle interface; 

● A data logging Lab Cradle interface to be connected, using a mini USB to USB cable, to a 

computer; 
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● Computer, one piece; 

● Mechanical pencil, one piece. 

 

 

 

Figure 2 - 3 – (3.1) Materials used in experiment 2 - 1.2 and (3.2) coil placement detail: setup used in 

2 - 1.1 (A), coil (B), three finger clamp (C), universal clamp (D), plastic tube with a pair of magnets 

(M1) in their rest position, bras mass (M2), conducting cables (E), voltage probe (F), Lab Cradle 

interface (G), mini USB to USB cable (H), Computer (I) and mechanical pencil (J). 

Your point absorber wave-generator model will be driven by the oscillations of the mass-spring 

system. To assemble the model, you will start with the mass-spring set up used in the experiment 2 

- 1.1. Append to this set up the 6000 turns coil by fixing it with a three finger clamp and a universal 

clamp to the vertical standing rod (see Figure 2 - 3.2). This coil should be fixed below the suspended 

spring. The spring axis and the coil central empty space axis should lie on the same vertical. From 

the spring bottom end you will suspend M2 and/or M1 (the plastic tube containing two bar magnets). 

To test your wave-generator’s capabilities you will first investigate its open circuit output voltage 

under different mechanical oscillation conditions. For that purpose, plug the voltage probe to the 

winding terminals of the 6000 turns of the coil (use the banana-alligator conducting cables). The 

access to the metallic voltage probe terminals proceeds as shown: 

 

Connect the voltage probe to the lab cradle interface (not connected to the TI-nspire calculator) 

and connect this interface to the computer. Login in the computer, using the username and password 

written in the instruction sheet that is next to it, and launch the software TI-Nspire CX CAS. 
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Instructions for operating with the data acquisition system and software are given in Appendix 4. 

During the experimental activities keep the software in the Graph view. Proceed as follows: 1. pull 

down the spring; 2. start data acquisition; 3. wait for the reference horizontal line to appear on the 

screen; 4. release the spring starting the voltage generation. The horizontal line will provide you 

with the reference (0 V) for your voltage measurements. By clicking on the acquired plot and using 

the arrow keys, you can read the coordinates of the points on your graph. To change the axes limits, 

write a new value over the current one. In the menu File you can find the key to save your data for 

a later review. 

Question 1.2.1 

For each mechanical oscillation condition (defined below from 1.2.1a to 1.2.1c), characterized by 

a period (𝑇) and an amplitude (𝐴), proceed as follows: 

● Adjust the position of the spring suspending hook (and of the coil fixing clamp, if needed) 

so that: when the system is at rest, one of the magnets inside the tube is above the top of 

the coil and the other is inside the coil central empty space (see Figure 2 - 3.2); the bar 

magnets can oscillate vertically along the coil axis (through the coil central empty space). 

● Stretch down the spring by 𝐴. In order to set A, you can make use of the scale marked on the 

plastic tube and of the reference provided by the top end of the coil. Start a data acquisition 

for about 3 seconds (choose a sampling rate of 200 samples/second). When the reference 

line appears on the chart, release the spring in order to get vertical oscillations. You will 

observe on the computer screen the output voltage (𝑉𝑔𝑒𝑛(𝑡)).  

Question 1.2.1a  

Set the first mechanical oscillation condition (C1) using the mass M1 in the mass-spring system and 

stretching down the spring by 3 cm. Analyse the output voltage of the wave-generator model in this 

C1 condition. 

❖ Sketch the graph of 𝑽𝒈𝒆𝒏(𝒕), starting from the reference and for a time interval 

of about 1 s, in box 1.2.1a on the answer sheet (include scales in the axes).  

❖ In your sketch indicate the voltage period (𝑻𝑽) and voltage amplitude (𝑽𝟎). 

❖ Record the values of 𝑴, 𝑨, 𝑻𝑽 and 𝑽𝟎 for C1 in Table 1.2 on the answer sheet. 

Question 1.2.1b 

Set the mechanical oscillation condition (C2) by keeping M1 in the mass-spring system and 

stretching down the spring by 2 cm. Analyse the output voltage of the wave-generator model in this 

C2 condition. 

❖ Record the values of 𝑴, 𝑨, 𝑻𝑽 and 𝑽𝟎 for C2 in Table 1.2 on the answer sheet. 

Question 1.2.1c  

Set the mechanical oscillation condition (C3) by suspending M1 from M2, in the mass-spring system 

and stretching down the spring by 2 cm. Analyse the output voltage of the wave-generator model in 

this C3 condition. 

❖ Record the values of 𝑴, 𝑨, 𝑻𝑽 and 𝑽𝟎 for C3 in Table 1.2 on the answer sheet. 
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Question 1.2.2 

❖ Indicate in Table 1.2 the values of the oscillation period ( 𝑻 ), for each of the three 

mechanical oscillation conditions (C1, C2 and C3). 

Question 1.2.3 

(1) The period of the wave-generator model output voltage is given by  ... [ 𝑇𝑉 = 𝑎𝑇 or 𝑇𝑉 = 𝑇 or 

𝑇𝑉 = 1/𝑇 or 𝑇𝑉 = 𝑇/𝑎 , where 𝑎 is a number greater than 1]. 

(2) The amplitude of the wave-generator model output voltage (𝑉0) increases with  ... [𝑇 or 𝑇/𝐴 or 

𝐴/𝑇 or 𝐴 ]. 

❖ Complete the two previous sentences with the option enclosed in square brackets 

that better fits your results under the Question 1.2.3..  

2 - 1.3. Storing electrical energy  

In order to use the power produced by the wave generator (harvested from the mechanical 

oscillations) an energy take-off system is required. In this task you will construct a simple take-off 

system for your point absorber wave-generator model. This system integrates a bridge rectifier 

circuit and a capacitor. 

Materials and equipment 

● The equipment used in task 2 - 1.2; 

● One breadboard; 

● Thin conducting wires (jumpers);  

● One red LED; 

● 4 germanium diodes; 

● A 1000 𝛺 resistor; 

● A 10000 𝜇F  electrolytic capacitor (that can be charged up to 16 V). 

   

  

Figure 2 - 4  – Equipment for mounting the take off circuit: breadboard (A), jumpers (B), LED (C), 

diodes (D), resistor (E) and capacitor (F). 

The breadboard (see Figure 2 - 5) is a base which provides you an easy way to assemble the take-

off circuit. The connections between the circuit elements are established by inserting their pin 

terminals and connecting wires (jumpers) into appropriate holes of the breadboard. Some of 
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breadboard holes are electrically connected by metal strips on the bottom of the breadboard, as 

marked in the Figure 2 - 5 by the black lines – aside from horizontal rows of 5 pins, connected sets 

of 5 pins run vertically along the sides.  

 
Figure 2 - 5 – Breadboard for the electric circuit assembly. The black lines show which holes are 

electrically connected. Please note that breadboard is symmetric between the top and the bottom part. 

A diode is an electric polarized component with two terminals – an anode and a cathode (see Figure 

below). Current can only flow through the diode if the anode is positively polarized and the cathode 

is negatively polarized (direct polarization) and if the external voltage is above a given threshold 

(about 0.35 V for germanium diodes you will use). If the polarization is reversed the diode behaves 

as an “open switch”. The electric symbol for a standard diode is displayed in the Figure below, 

where the direct polarization and current direction are also shown. Diode packages (glass for your 

germanium diodes) have a thick painted bar near one end, indicating the cathode. 

Anode Cathode 

A capacitor is a circuit component that can be charged, storing electrical energy. When a capacitor 

is at the voltage 𝑉𝐶, it stores the energy 

 

where 𝐶 is the capacitance, which represents the capacitor ability to store electrical charge. 

Below, you find a Table with the schematic symbol for a polarized capacitor and for other circuit 

components you are going to use, as well as important information about these components.  

 

Circuit component Symbol Description 

Inductor  An inductor is a coiled conductive wire. Changes in the current 

across an inductor, cause variations in the coil magnetic 

environment which involve energy transfer.  

Resistor 
 

A resistor is a conductor with a given resistance. For a given 

applied voltage, the current through the resistor is directly 

proportional to its resistance.  

Polarized capacitor 

 

To charge a polarized capacitor, it should be placed correctly, 

with the “+” terminal, which is marked on the device, at the 

higher potential. 

Light emitting diode 

 

This is a type of diode that emits light when a current flows 

through it. The longer LED terminal is the anode and it should 

be polarized positively for the LED to emit light. 

 

 

 

i 
+ - 
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The Bridge Rectifier 

Your point absorber wave-generator model may supply an alternating current (AC) which 

periodically reverses direction. A direct current (DC), which flows only in one direction, must be 

used to store electrical energy in a capacitor (otherwise, the capacitor will charge and discharge 

periodically). A bridge rectifier is a circuit that converts AC current into DC current using diodes. 

When measuring the voltage between two points, connect the black terminal of your voltage probe 

to the lower potential point and the red one to the higher potential point. 

Question 1.3.1 

Connect a LED to the 6000 turns coil (use the banana-alligator conducting cables) as shown below. 

 

Connect one of the voltage probes at point A and the other at point B -   Use M1 and impose 𝐴 = 3 

cm (condition C1 also used in 1.2.2a) to the mass-spring system. Start the data acquisition for 10 s.  

❖ Sketch the graph of 𝑽𝒈𝒆𝒏(𝒕), starting from the reference and for a time interval 

of about 3 s, in box 1.3.1 on the answer sheet (include scales in the axes).  

❖ In your sketch indicate the time intervals corresponding to the two first LED 

flashes.  

 
Question 1.3.2 

Compare the sketches in box 1.2.1a and box 1.3.1. Classify as true (T) or false (F) each of the 

following statements. Wrong answers will be penalised (-0.5 marks). 

(1) When the wave-generator model is connected to the LED, the period of 𝑉𝑔𝑒𝑛(𝑡) decreases. 

(2) When the wave-generator model is connected to the LED, the mass-spring system is 

continuously suffering damping caused by the magnetic environment created by the coil. 

(3) When current flows through the LED some mechanical energy from the mass-spring system is 

transferred to the coil electromagnetic field. 

(4) Unlike the mass-spring system, the sea waves are a continuous source of mechanical energy. 

❖ Circle the right sentences in the the answer sheet, box 1.3.2 

Question 1.3.3 

From your data, is it possible to find which is the threshold voltage for the LED conduction? If yes, 

indicate that threshold. 

❖ Provide your answer in the the answer sheet, box 1.3.3. 
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Question 1.3.4 

Disconnect the LED from the wave-generator model. Assemble the bridge rectifier circuit (be 

careful to do not break the diodes glass package near the diode terminals) according to the following 

circuit diagram (use the breadboard) and connect it to the 6000 turns coil (also shown in the 

diagram). If you need you can get one (and only one) extra diode but you will lose points (see 

below).  

 

Figure 2 - 6 – Circuit diagram for the bridge rectifier circuit. The circuit is composed by the 

wave generator coil (1) and four diodes (2, 3, 4 and 5). 

Question 1.3.4a 

In addition to the provided 4 diodes you may use 1 extra diode (to replace a broken diode) under 

request to the physics lab assistant. No more than one extra diode can be used and if you use it you 

will lose 2 points if you ask to use this spare diode. 

❖ If an extra-diode is used, you should state it in the answer sheet, box 1.3.4a. Both 

you and the lab assistant will sign that statement. You will lose 2 points. 

Question 1.3.4b 

Connect the voltage probe to analyse for 2 seconds the voltage between points A and B ( 𝑉𝑔𝑒𝑛(𝑡) , 

starting from the reference) generated when using M1 in the mass-spring system and by imposing 

𝐴 = 3 cm to the spring. Repeat the procedure but this time connecting the voltage probe between 

points C and D ( 𝑉𝑏𝑟𝑖𝑑𝑔𝑒(𝑡) ).  

❖ Sketch the graphs of 𝑽𝒈𝒆𝒏(𝒕) and 𝑽𝒃𝒓𝒊𝒅𝒈𝒆(𝒕) starting from the reference and for 

a time interval of 2 s (include scales in the axes). 

Question 1.3.5 

In the following diagrams signs (+) and (-) indicate voltage polarizations. Which diagram/diagrams 

correctly relate the bridge DC output voltage (between points C (𝑉𝐶) and D (𝑉𝐷)) with the bridge 

AC input voltage (between points A (𝑉𝐴) and B (𝑉𝐵)?  
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(1) 

 

(2) 

 

(3) 

  

(4) 

 

 

❖ Circle the number/ numbers of the correct diagram/diagrams in the the answer 

sheet, box 1.3.5. 

 
Capacitor charging 

You will use an electrolytic capacitor as the electrical energy storage device. This device has the 

capacity to store charge when a voltage is applied to its terminals. In the following experiments you 

are going to perform with the wave-generator model, only a small amount of charge is stored. 

Therefore, it is safe to discharge the capacitor by connecting its terminals with a conducting wire. 

Use this procedure whenever you need to have your capacitor discharged. 
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Question 1.3.6 

Connect the RC series – the electrolytic capacitor in series with the resistor (for limiting current) – 

to the bridge rectifier as shown in Figure 2 - 7. 

 

Figure 2 - 7 – Circuit diagram for connecting the series of the electrolytic capacitor (6) and the resistor 

(7) to the bridge rectifier. 

Question 1.3.6a  

Discharge the capacitor. Connect the voltage probe in order to analyse for 10 s the voltage between 

points A and B ( 𝑉𝑔𝑒𝑛(𝑡) ). Use M1 and impose 𝐴 = 3 cm. Save your data. 

❖ Sketch the graphs of 𝑽𝒈𝒆𝒏(𝒕) starting from the reference and for a time interval 

of 3 s, in box 1.3.6a on the answer sheet (include scales in the axes). 

Question 1.3.6b  

Discharge your capacitor. Connect the voltage probe in order to analyse for 10 s the capacitor voltage 

( 𝑉𝐶(𝑡) ). Use M1 and impose 𝐴 = 3 cm. 

❖ Sketch the graphs 𝑽𝑪(𝒕) starting from the reference for a time interval of 10 s, in 

box 1.3.6b on the answer sheet (include scales in the axes). 

What is the value (𝑉𝐶𝑇) reached by 𝑉𝐶(𝑡) after the first oscillation period?  

❖ Indicate the value of VCT in the plot and write the numerical value below the plot 

in the answer sheet, box 1.3.6. 

Question 1.3.7 

Note that the maxima of 𝑉𝑔𝑒𝑛(𝑡) have decreasing values in time, i.e. that voltage amplitude decays 

over time. The 𝑉0 decay is approximately exponential:  

 

where 𝑉1, 𝑉2 and 𝛾 are constants. 𝛾 is the damping ratio and it characterizes the rate of energy loss.  

From your experimental data extract the value of 𝑉2 and of a set of (𝑉0, t ) pairs. 

❖ Record the values in Table 1.3 on the answer sheet. 

Question 1.3.8 

Use the TI-Nspire software (see Appendix 4) to create two “manual columns” with the values 

recorded in 1.3.7. Create a “calculated column” with the values of 𝑙𝑛 (𝑉0 −  𝑉2)  and fulfil the last 
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column of table 1.3.7. Draw the plot of  𝑙𝑛 (𝑉0 − 𝑉2)  as a function of time.  

❖ Fill Table 1.3 with the values calculate for 𝒍𝒏 (𝑽𝟎 −  𝑽𝟐)  . 

Question 1.3.9 

With the TI-Nspire software (see Appendix 4), adjust your plotted data to a linear fit line.   

❖ Write the linear fit parameters and the quality fit parameter r2, given by the 

software, in the answer sheet, box 1.3.9. 

❖ Present your value for 𝛾 in the answer sheet, box 1.3.9. 

Question 1.3.10 

As 𝑉0 drops, 𝐴 (the amplitude of the mechanical oscillation of the mass-spring system) also drops 

and the mass-spring system loses energy. Both are approximately characterized by the same 

damping constant (𝛾):  

 

where 𝐴0 is the initial amplitude.  

The efficiency of your wave-generator model working in the above condition for the storage of 

energy (𝜂) is the ratio between the energy stored in the capacitor and the energy lost by the mass-

spring system. 

Calculate the energy stored in the capacitor (𝐸𝐶) and the energy lost by the mass-spring system 

(𝛥𝐸𝑒𝑙𝑎𝑠𝑡) during the first oscillation period. Determine the corresponding energy conversion 

efficiency (𝜂). 

❖ Provide your answer in the answer sheet, box 1.3.10.  

 

Question 1.3.11 

In the open sea, waves continuously transfer energy to the translator.  Do you see any simple way 

to do the same with your mass spring system? Implement your idea to increase 𝑉𝐶(𝑡) up to 3 V. 

Then connect the RC series to the LED to make it light up. Does the LED light up for a while? If it 

does, call the physics lab assistant to show him/her. 

❖ Provide your answer in the answer sheet, box 1.3.11. If the answer is yes, you and 

the lab assistant should sign. 

 

 

 

 

 

TASK 2 - 2.: MARINE ECOSYSTEMS: BIODIVERSITY AND RESOURCES 

You are now asked to characterise the populations within the ecosystem found in the vicinity of the 

wave generator. You will use those biological samples that were collected in open sea by Isabel and 
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Vasco. 

This task includes an agarose gel electrophoresis that takes at least 1 h. To finish your 

work on time, we strongly advise starting with the section 2 - 2.1.: “Bivalve taxonomic 

identification”. 

 

2 - 2.1. Bivalve taxonomic identification  

Introduction 

Isabel and Vasco were particularly curious about the mussels attached to the wave generator’s 

structure. They tried to classify them through images using a book guide and found that the mussels 

should belong either to the species Mytilus galloprovincialis (M. galloprovincialis) or Mytilus 

trossulus (M. trossulus), which can easily interbreed and produce hybrids. It is very difficult to 

distinguish M. galloprovincialis from M. trossulus using just morphologic characteristics (Figure 2 

- 2.1), but they can easily be  discriminated based on the analysis of their DNA. So, Isabel and Vasco 

are asking for your help to distinguish the samples. They discovered that there is a significant 

difference between M. trossulus and M. galloprovincialis in a gene that encodes an adhesion protein. 

This protein is used for making the byssal threads, which mussels use to attach themselves to a 

substrate: in M. galloprovincialis, there is a deletion in DNA that codes for the adhesion protein 

gene.  

 

Figure 2 - 2.1 – Photograph of Mytilus galloprovincialis and Mytilus trossulus. 

 

If necessary, use the Glossary at Appendix 5 (words in the Glossary are indicated 

by an asterisk “ * ”). 

Due to the deletion in this gene in one of the species, it is possible to discriminate both species by 

PCR*, using specific primers*: M. trossulus yields a fragment that is longer (more base pairs (bp)), 

whereas M. galloprovincialis yields a shorter fragment (less bp). This difference is clearly 

distinguishable by agarose gel electrophoresis.  

Isabel and Vasco have previously performed the PCR* reaction using DNA from 3 different mussels 

(A, B and C) collected at the generator and a mixture of two pairs of primers* (2 forward and 2 
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reverse). One pair of primers* is specific to amplify a fragment of the gene that codes for the adhesive 

protein - amplification may give rise to products of different lengths, depending on the mussel 

species. The other pair of primers* amplifies another DNA sequence that is conserved in both 

species, giving rise to the shorter single product that is used as a positive control of the reaction. 

You have these PCR* products in tubes identified by A, B and C, kept in ice. To visualize and sort 

your PCR* products you need to do an agarose gel electrophoresis with a DNA stain (visible under 

UV light).  

In addition to your PCR* products, you will also be running a DNA molecular weight ladder* as a 

size marker.  

You are asked to analyze the PCR* products resulting from amplification of the DNAs from mussels 

that were attached to the generator, helping Isabel and Vasco to identify the mussels they collected.  

Materials and equipment 

● Ice box with 5 tubes: PCR products from DNA A, B or C (labelled as “A”, “B” and 

“C”), DNA ladder (labelled as “L”) and Orange G loading buffer (labelled as “LB”) 

● 10 empty 1.5 mL tubes, in the tube holder 

● Micropipettes: 1000 μL, 200 μL and 20 μL, 1 piece each  

● 20-200 μL Micropipette tips, 1 box 

● 1000 μL Micropipette tips, 1 box 

● Electrophoresis gel apparatus with an 1.5% (w/v) agarose gel and TBE 0.1X buffer 

● Erlenmeyer with electrophoresis buffer TBE 0.1X Buffer solution (labelled as “TBE 

0.1X”) 

● Microcentrifuge, one for each two teams 

● UV transilluminator, to share with the other teams (located in another room - to use 

with the help of a Lab assistant) 

Any additional above-mentioned material will cost you 5 marks. Additional DNA samples or 

agarose gel will cost you 10 marks each. 
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2 - 2.1.1. Preparation of the samples containing the PCR products for electrophoresis  

1. Prepare the PCR* products (A, B and C) and the DNA ladder according to the following 

scheme. Label 4 clean 1.5 mL tubes, and prepare the following mixtures: 

Tube I - 15 μL of PCR product from DNA A + 3 μL of Orange G loading buffer* 

Tube II - 15 μL of PCR product from DNA B + 3 μL of Orange G loading buffer*  

Tube III - 15 μL of PCR product from DNA C + 3 μL of Orange G loading buffer*  

Tube IV - 15 μL DNA ladder + 3 μL of Orange G loading buffer*  

2. Mix the solutions well using the pipette and ask an assistant for help to pulse-centrifuge 

the reaction mixtures using the microcentrifuge. 

2 - 2.1.2. Loading the samples in the agarose gel 

In your work station you will find an electrophoresis apparatus with an 1.5% (w/v) agarose gel 

submersed in electrophoresis buffer.  

If the gel is not entirely submersed, pour some more buffer in the tank. The wells must be totally 

submersed. 

Load the 18 μL of each sample from tubes I to IV  (DNA + loading buffer*) into the wells of your 

gel, by slowly pouring the sample in the middle of the well. After loading the sample, slowly remove 

the pipette tip from the well keeping the dispenser pressed. Reject that tip and use a new one to repeat 

the procedure for the next sample, loading it in the adjacent well. Repeat the procedure for all 

samples, including the DNA ladder*. Be sure to carefully load each sample in a different well! Figure 

2 - 2.2 indicates how to load the wells. 

Be careful not to damage your gel!  

 

Figure 2 - 2.2 – Schematic representation of the electrophoresis process. S – slots/wells. 
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2 - 2.1.3. Running Electrophoresis 

Before running the electrophoresis, make sure that all samples were loaded, the gel is submersed in 

the buffer, and that the wells of the gel are near the black electrode. Put the lid over the tray, as it 

was previously and then plug in to run the electrophoresis. Check for air bubbles at the side of the 

(red) electrode otherwise call lab assistant for help. After a few minutes you should see an orange 

band migrating away from the well, running towards the red electrode at end of the gel. See Figure 

2 - 2.2. 

Question 2.1a 

Complete the legend of the gel (the positions of each sample (I to IV)), considering that well # 1 is 

the one at your left. Figure 2 - 2.2 indicates how to load the wells.  

Enter the legend of your gel Question 2.1.a in the answer sheet. 

2 - 2.1.4. Analysis of the gel 

After 1 hour, ask for assistance to check if you can stop the electrophoresis. By the third hour of the 

task, you should go to photograph your gel. By that time, the schematic representation will be given 

to you, even you do not succeed in running the gel. Incomplete running/no running will be penalized. 

After finishing the electrophoresis, ask for an assistant to accompany you to an UV transilluminator. 

There, you can check the presence of DNA bands in your gel. 

1. The assistant will photograph your gel and will attach the photo to your answer sheet.  

Question 2.1b 

A photo of your gel will be attached to the answer sheet.  

❖ The photo of your gel will be attached under Question 2.1.b in the answer sheet. 

2. At that time, the assistant will give you a schematic representation of the gel. This image 

corresponds to the same PCR products ran in the same conditions as yours. Use this image 

to answer the Questions 2.1c-2.1g in the answer sheet. Consider that both species are present 

in the samples collected. 

Question 2.1c 

According to the image (schematic representation) provided, identify the number of the well in 

which PCR products from DNA of M. trossulus were loaded. 

❖  Select the correct option in Question 2.1.c in the answer sheet. 

Question 2.1d 

According to the image provided, identify the number of the well in which PCR products from DNA 

of M. galloprovincialis were loaded. 

❖  Select the correct option in Question 2.1.d in the answer sheet. 

Question 2.1e 

From these results do you think that Isabel and Vasco have collected an hybrid mussel (a cross-breed 

between M. trossulus and M. galloprovincialis)? 

❖  Select the correct option in Question 2.1.e in the answer sheet. 
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Question 2.1f 

Which PCR products are appropriate to choose the answer to question 2.1e? 

❖  Select the correct option in Question 2.1.f in the answer sheet. 

Question 2.1g 

Based on the information of the DNA Size Ladder in Appendix 5, fill in the table, indicating the 

approximate molecular weight (number of base pairs) of each band, in each sample (use Figure 3 in 

Appendix 5). 

❖ Enter your answer to Question 2.1.g in the answer sheet. 

Question 2.1h 

For a more accurate resolution of a DNA sample, which agarose gel concentration should you 

prepare? 

❖  Select the correct option in Question 2.1.h in the answer sheet. 

Question 2.1i 

Regarding DNA charge, choose the correct option. 

❖ Select the correct option in Question 2.1.i in the answer sheet. 

 
2 - 2.2. Marine bacteria diversity associated with the wave energy device 

In addition to helping the harvesting of multicellular living beings, Isabel and Vasco also collected 

samples by scraping structures from the wave generator. Their research group was interested in 

analyzing the different bacterial populations that could be fixed to the wave generator device. 

Materials and equipment 

● One 1.5 mL tube with marine bacteria sample (labelled as “MB”), on the tube holder 

● Neubauer chamber with cover slip, 1 piece 

● Optical microscope, 1 piece 

● Micropipettes: 1000 μL, 200 μL and 20 μL, 1 piece each 

● 20-200 μL Micropipette tips, 1 box 

● 1000 μL Micropipette tips, 1 box (shared with Task 2 - 3) 

● Immersion Oil (labelled as “Immersion Oil”), 1 piece 

● Calculator, 1 piece 

● Hand tally counter , 1 piece 

● One plate with marine bacteria “A” (labelled as “A”) 

● One plate with marine bacteria “B” (labelled as “B”) 

● One Gram-stained slide with isolate “A” (labelled as “A”) 

● One Gram-stained slide with isolate “B” (labelled as “B”) 

http://azurawave.com/projects/hawaii/
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● Sterile loop, 10 pieces 

● One 1.5 mL tube with H2O2 (3%, v/v), on the tube holder (labelled as “H2O2”) 

● Clean glass slides, 1 box 

● Tweezer, 1 piece 

● Oxidase discs inside a small Petri dish, 3 pieces (labelled as “OX”) 

● One glass tube containing 5 mL of bacterial culture “A” (labelled as “A”) 

● One glass tube containing 5 mL of bacterial culture “B” (labelled as “B”) 

Any additional above-mentioned material will cost you 5 marks. Additional bacteria samples 

or Gram stained slides will cost you 10 marks. Breaking the Neubauer chamber will cost you 

10 marks. 

2 - 2.2.1. Enumeration of bacterial cells 

You are now asked to help Isabel and Vasco! First, you are going to determine the number of 

bacterial cells collected from the surface of the wave energy device. To do that, two experimental 

approaches (Neubauer chamber and cell viable count) will be used. At the end you should be able 

to discuss the results in terms of the numbers of bacteria counted with the two methodologies used. 

2 - 2.2.1.1. Total bacterial cells (Neubauer chamber) 

A sample (“MB”) collected from the wave energy device was previously diluted to a suitable 

concentration for cell counting (1:10).  

Preparation of the slide and cell counting 

1. Start by putting the clean glass cover on the Neubauer chamber central area. 

2. With the aid of a micropipette, mix sample by pipetting up and down.  

3. With the aid of a micropipette, introduce the sample (200 μL) into the Neubauer chamber. To 

do that, adjust the tip of the micropipette to the edge of the chamber (into the left groove of the  

Neubauer counting chamber) and gently release the liquid until the chamber is full (avoid 

introducing air bubbles). 

4. Place the chamber on the platform of the microscope focusing initially with a 100× 

magnification (an entirely central square divided into 25 small squares should be observed). 

5. Change the magnification to 400×. You may need to reduce the amount of light by closing the 

diaphragm of the condenser to be able see the cells. Perform the count in 5 small squares (each 

one divided into 16 smaller squares) within the central large square (Figure 2 - 2.3.). 

6. Count the cells with the help of the hand tally counter. 

Follow the criteria: 1) If cells fall on a line, include in your count those on the top and left-

hand lines and exclude those on the bottom and right-hand line (Figure 2 - 2.3.); 2) Cells may 

have the propensity to aggregate. You should avoid counting these aggregates. 
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Figure 2 - 2.3 – General features of the counting chamber to be used. 1 - Central large square (100× 

magnification); 2 - Small square (400× magnification) (divided into 16 smaller squares) 

Question 2.2.a. 

Use the results obtained to fill the table and calculate the total number of cells per mL. 

❖ Write your answer under Question 2.2.a in the answer sheet. 

2 - 2.2.1.2. Estimation of viable bacterial cells 

The same sample “MB”, collected from the wave energy device, was serially diluted with sterile 

seawater. A spread plate method was employed for the estimation of viable bacteria. Marine agar 

was used as the culture medium; the plates were inoculated (100 μL) followed by their incubation 

at room temperature for 1 week. Colonies were counted for each dilution and the results are 

presented in the Table below.  

 

 Serial dilutions of the sample “MB” 

 10-3 10-4 10–5 

Count 210 20 2 

 

Question 2.2.b. 

Calculate the total number of viable cells per mL of sample, expressing the results as colony forming 

units (CFU) per mL (original solution). Record your calculations. 

 

❖ Write your answer under Question 2.2.b in the answer sheet. 
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2 - 2.2.2. Gram staining of bacteria associated with the wave energy device  

Gram staining is a staining technique that differentiates bacteria into two major groups, namely 

Gram–positives and Gram–negatives. The procedure is based on the ability of bacteria to retain 

color of the stains used. Gram–negative bacteria are decolorized by alcohol, losing the color (purple) 

of the first stain (crystal violet). Gram–positive bacteria are not decolorized by alcohol and will 

remain as purple. After decolorization, a counterstain is used to impart a pink color (safranin) to the 

decolorized Gram-negative organisms (Figure 2 - 2.4.). 

 

Figure 2 - 2.4 – Gram staining of Gram-positive (A)  and Gram-negative (B)  bacteria. Photo obtained 

from mycrobe.org 

Pure cultures of the most abundant bacteria isolated from the wave energy device were streaked and 

cultivated on marine agar plates. Two of the most representative are available in your laboratory 

bench (designated by isolates “A” and “B”).  The Gram staining of each isolate was previously 

performed (slides “A” and “B”). Observe the two slides under the microscope. 

2 - 2.2.2.1. Microscope observation of the slides 

Focus and observe the slides using the objectives of lower magnification (10×, 40×). For oil 

immersion (100×), add the oil directly to the smear and re-focus the slide with the fine adjustment 

knob. 

Question 2.2.c. 

Use a pen to draw pictures of the bacterial cells (morphology and the arrangement) observed under 

the 100× objective. Indicate the Gram reaction. For the interpretation of your results take in 

consideration the representative photos of Gram-positive and Gram-negative bacteria in Figure 2 - 

2.4. 

❖ Write your answer under Question 2.2.c in the answer sheet. 

2 - 2.2.3. Biochemical characterization of bacteria associated with the wave energy 

device 

To perform the biochemical tests use the two marine bacterial isolates (“A” and “B”) previously 

selected, that are cultivated on marine agar plates.  

http://mycrobe.org/
http://azurawave.com/projects/hawaii/
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2 - 2.2.3.1. Catalase test (antioxidant assay) 

This test is used to demonstrate the activity of the enzyme catalase, needed to convert hydrogen 

peroxide (H2O2) into oxygen and water. The presence of the enzyme is determined when a bacterial 

inoculum introduced into H2O2 causes an immediate effervescence (release of O2 observed by the 

visualization of bubbles). 

1. With a sterilized loop place a small amount of the bacterial culture from the plate on a clean 

glass slide.  

2. Add a few drops of H2O2 (3%, v/v) and watch for the production of bubbles in the suspension 

(existence of effervescence; release of O2). If no bubbles are produced the test is negative for 

catalase activity. Compare your results with reference photos in Figure 2 - 2.5. 

3. Perform these procedures for both cultures “A” and “B”. 

 

 

Figure 2 - 2.5 – Catalase test, showing negative (-) and positive (+) results. 

 

Question 2.2.d 

Record the results of your experiments in the Table using a (+) for a positive test and a (-) for a 

negative test.  

❖ Write your answer under Question 2.2.d in the answer sheet. 

2 - 2.2.3.2. Oxidase test 

This test is used to demonstrate the activity of the enzyme cytochrome c oxidase, which is involved 

in the final step of the respiratory electron transfer chain. The presence of the enzyme is determined 

when a bacterial inoculum causes the oxidation of the substrate (tetramethyl-p-phenylenediamine 

dihydrochloride) to indophenol (a dark purple colored product). 

1. With a sterilized loop add a portion of the bacterial culture on an oxidase disc (OX). For that 

place the disc on a slide with a tweezer, and then transfer a small amount of the bacteria culture 

from the plate using the loop. 

2. Observe the result (positive test indicated by the development of a dark purple colour; bacterial 
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isolate produces the enzyme). The reaction is observed within 2 minutes at room temperature. 

Compare your results with reference photos in Figure 2 - 2.6. 

3. Perform these procedures for both cultures “A” and “B”. 

 
Figure 2 - 2.6 – Oxidase test, showing negative (-) and positive (+) results. 

 

Question 2.2.e 

Record the results of your experiments in the Table using a (+) for a positive test and a (-) for a 

negative test.  

❖ Write your answer under Question 2.2.e in the answer sheet. 

 

2 - 2.2.3.3. Biofilm formation 

A procedure to determine the ability of bacteria to produce biofilms is the so-called “static 

microcosms” bioassay. Biofilms are observed at the air-liquid interface within a glass tube 

containing 5 mL of culture medium (marine broth) previously inoculated with 50 µL of a freshly-

grown bacterial culture. Tubes are allowed to incubate for 1 day, without shaking, at 22 ºC, after 

which biofilm production at the air-liquid interface can be detected by naked eye or, alternatively, 

with the assistance of a loop.    

1. Carefully observe each of the two static microcosms (glass tubes) provided, inoculated with 

Isolate A and Isolate B.  Is there any sort of cellular mass identifiable at the air-liquid interface 

by naked eye?  

2. Touch the air-liquid interface of each static microcosm (Isolate A and B) with a sterile loop, 

and record whether or not cellular material can be recovered from the surface of the liquid 

medium. If yes, the microcosm can be scored as biofilm-positive. 

3. Perform these procedures for both cultures “A” and “B”. 

Question 2.2.f 

Record the results of your experiments in the Table using a (+) for a positive test and a (-) for a 

negative test.  

❖ Write your answer under Question 2.2.f in the answer sheet. 



EUSO 2019 Seite 65 

 

 

Question 2.2.g.  

Which of the options is a disadvantage of the direct microscopic count of bacterial cells? 

❖ Select the correct option in Question 2.2.g in the answer sheet. 

Question 2.2.h.  

In a viable plate count technique, each … represents a … from the bacterial sample. 

❖ Select the correct option to fill the blanks (...) in Question 2.2.h in the answer sheet. 

Question 2.2.i.  

What is the name of the period between inoculation of bacteria in a culture medium and the 

beginning of its multiplication? 

❖ Select the correct option in Question 2.2.i in the answer sheet. 

Question 2.2.j  

What is the composition of a bacterial cell wall? 

❖ Select the correct option in Question 2.2.j in the answer sheet. 

Question 2.2.k  

Which cell component is differentiated by the Gram staining technique? 

❖  Select the correct option in Question 2.2.k in the answer sheet. 

Question 2.2.l.  

Which two cell components exist in bacteria? 

Select the correct option in  Question 2.2.l in the answer sheet. 

 

Question 2.2.m.  

What is catalase? 

❖ Select the correct option in  Question 2.2.m in the answer sheet. 

Question 2.2.n.  

Why may biofilm production by marine bacteria be advantageous? 

❖ Select the correct option in Question 2.2.n in the answer sheet. 
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TASK 2 - 3.: BIOTECHNOLOGICAL POTENTIAL OF GREEN AND RED ALGAE 

Introduction 

Heavy metals are major pollutants in marine, ground, industrial, and even treated waters. Sorption 

of heavy metals onto live or dead biological materials (biosorption) is a potential method for 

removing or recovering toxic and precious metals from wastewater. Successful metal biosorption 

can be achieved by a variety of biological materials including microalgae and seaweeds.  

Here you will help Vasco and Isabel to evaluate the biotechnological potential of two seaweeds that 

were collected close to the wave generator prototype. You will test the seaweed’s potential as new 

materials for metal biosorption. Zinc  will be the tested metal. 

The green algae Ulva sp. and the red algae Gymnogongrus sp. were collected. After collection, algae 

were carefully freed of foreign matter, extensively washed, oven dried at 60 ºC for 72 hours, and 

then grounded. Algae were stored in a fresh bench and in a stoppered flask.  

 

Figure 2 - 3.1 – Green algae Ulva sp. and red algae Gymnogongrus sp. 

 

2 - 3.1. Biosorption isotherms 

You will determine the Zn (II) ions uptake capacity by the red and the green algae. The objective is 

to determine which algae have the greatest potential to be used in a water treatment station to treat 

water contaminated with heavy metals. For this you will need to evaluate how much zinc  can be 

absorbed by the algae. You will prepare zinc  solutions with different concentrations and use samples 

of green and red algae, stir them for some time in the presence of the different solutions and then 

quantify the final Zn (II) ions in solution.  

Materials and equipment 

● 50 mL glass bottles with 0.05 g grounded dried Green Algae, 6 pieces 

● 50 mL glass bottles with 0.05 g grounded dried Red Algae, 6 pieces 

● Volumetric pipettes: 100.00 mL, 25.00 mL, 20.00 mL, 1 piece each 

● Volumetric pipettes: 50.00 mL, 10.00 mL, 2 pieces each 

● Pipette: 5.00  mL, 3 pieces  

● Disposable plastic Pasteur pipettes, 3 pieces 

● Pipette filler bulb, 1 piece (general tray) 

● Micropipettes: 1000 μL, 200 μL and 20 μL, 1 piece each 

● 20-200 μL Micropipette tips, 1 box with 96 tips 

● 1000 μL Micropipette tips, 1 box with 96 tips (shared with Task 2 - 2.2) 

● 25.00 mL burette, 1 piece 

● 250 mL volumetric flask, 5 pieces 

● 10 mL volumetric flask, 4 pieces 
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● 500 mL plastic beaker for waste, 2 pieces 

● 100 mL Erlenmeyer flask, 2 pieces 

● 25 mL beaker, 6 pieces 

● 4 cm ⌀ funnel, 1 piece  

● Magnetic stirrer, 2 pieces 

● Magnetic stirrer bar, 12 pieces 

● 1 cm length/2 mL plastic cuvette with covers, 30 pieces 

● 1.3 g.L-1 Zincon solution, 1.5 mL, labelled as “Zincon” 

● Primary Zn (II) (II) standard solution, 500 mL, labelled as “Sol P” 

● 0.010 mol.L-1 EDTA solution, 50 mL, labelled as “0.010 mol.L-1 EDTA” 

● 0.0050 mol.L-1 MgCl2 solution, 50 mL, labelled as “0.0050 mol.L-1 MgCl2” 

● Eriochrome black T solution, 5 mL, labelled as “ErioT” 

● Sodium carbonate-bicarbonate (Na2CO3/NaHCO3) Buffer solution, pH 10.5, 20 mL, 

labelled as “Na2CO3/NaHCO3 pH 10.5” 

● Sodium borate saline (Na2B4O7) Buffer solution, pH 9.0, 5 mL, labelled as “Na2B4O7  pH 

9” 

● Deionized water in 500 mL plastic wash bottle, 2 pieces (labelled as “H2O”) (can be 

refilled if needed without penalty). 

● Colorimeter, 1 piece 

● TI-Nspire CX calculator, 1 piece 

● Scientific calculator TI-30X, 1 piece (general tray) 

●  Clock in the wall, (2 per lab) 

 

In case you spill a chemical, or break a piece of glassware, ask a replacement to a supervisor.  

Any additional above mentioned laboratory material will cost you 5 marks unless otherwise 

stated. An additional algae sample or solution will cost you 10 marks.  

 
2 - 3.1.1. Samples for equilibrium Zn(II) quantification 

Preparation of Zn (II) standards with known concentration 

Using the Primary Zn (II) stock solution (Sol P), prepare 5 diluted solutions according to the values 

indicated in the table below in 250 mL volumetric flasks.  

 
Dilution of Primary Zn (II) Solution (Sol P) 

2.5× 5× 10× 25× 50× 

 
Question 3.1.1 

Calculate the volume of Sol P needed to prepare each of the standard diluted solutions of Zn (II). 

❖ In Table 3.1.1 in the answer sheet, write the volumes of Sol P you used for the 

preparation of each Zn (II) standard 
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The concentration of Sol P is unknown until it is determined in section 2 - 3.1.2. 

 

1. Label the 250 mL volumetric flasks with the dilution (2.5×, 5×, 10×, 25×, 50×).  

2. By using the pipette filler bulb (see in the Appendix 7) and the appropriate pipette, transfer the 

necessary volume of Sol P to each of the 250 mL volumetric flasks.  

3. Add deionised H2O to the flask to about one cm below the mark line. Fill the flask to the mark 

line using a Pasteur pipette.  

Using 6 green and 6 red algae samples: 

1. Use 6 of the given 50 mL bottles containing 0.050 g of green or red algae and label them with 

the type of algae and the value of the zinc solution standards (Sol P, 2.5×, 5×, 10×, 25×, 50×). 

2. Add 50 mL of each of the zinc solution standards to the appropriate flask, including Sol P. You 

will need to prepare a total of 12 bottles, 6 bottles of different concentration (Sol P, 2.5×, 5×, 

10×, 25×, 50×) for each algae.  

Use the same 50 mL pipette for all solutions. You do not need to clean the pipette 

between solutions. Start by taking 50 mL from the highest dilution (50x) to the green 

and red algae flasks then take 50 mL from the next dilution (25x) and proceed 

accordingly until the lowest dilution (SolP) (this corresponds going from the lowest 

to the highest concentration). 

 

Pipetting order 

Red algae Green algae 

Flask 
Volume 

mL 
Flask 

Volume 

mL 

50× 50 50× 50 

25× 50 25× 50 

10× 50 10× 50 

5× 50 5× 50 

2.5× 50 2.5× 50 

Sol P 50 Sol P 50 
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3. Add a magnetic stirrer bar to each one of the 50 mL bottles and stir them continuously for not 

less than 90 minutes (clock in the Lab wall)  at room temperature using the magnetic stirrer. 

Do NOT switch on the hot plate on the magnetic stirrer!  

The experiment must be done at room temperature. 

While you wait for not less than 90 minutes proceed to section 2 - 3.1.2 for the 

determination of the Zn(II) concentration of solution P.  

 
4. After 90 minutes stop the agitation and wait to allow the algae particles to rest at the bottom of 

the flask. Proceed to 2 - 3.1.4. for metal quantification.  

 

2 - 3.1.2. Determination of the concentration of a standard solution of Zn (II) (Sol P) 

 

The primary standard solution of Zn (II) ion (Sol P) was prepared by dissolving a precise amount 

of ZnSO4.7H2O in H2O in a 500 mL volumetric flask. The amount of ZnSO4.7H2O weighted was 

written in the flask label, but unfortunately the label of the solution was damaged and it is not 

possible to read know the weight of ZnSO4.7H2O used to prepare the solution. 

Your task is to determine which of the four  (a to d ) was weighted to prepare the solution: 

a) 12.50 mg 

b) 125.0 mg 

c) 1.250 g 

d) 12.50 g 

For this you will perform a complexometric determination of Zn (II) with EDTA by back titration 

with MgCl2. You will determine an approximate concentration of Zn (II) in mol.L-1 and mg.L-1 in 

Sol P and therefore you must choose the nearest value from the above list. 

You will use a chemical reagent that forms a complex with Zn (II) ions to determine the 

concentration of zinc in solution. The complexation agent is the anion of ethylenediamine tetraacetic 

acid, abbreviated  as  EDTA. This ion has the ability to “wrap” itself around positive metal ions in 

water solution. This process is called chelation or complex formation. The chelation reaction 

between EDTA and many metal ions has a very large equilibrium constant,  1 mol of EDTA will 

react with  1 mol of (Zn2+).  

For Zn (II) ions in water the reaction with EDTA is as follows : 

           Zn2+(aq) + EDTA4-(aq)    ⇄   [Zn(EDTA)]2-(aq) 

To detect the ending point of the titration a metallochromic indicator will be used. Metallochromic 

indicators are organic compounds that originate different colours when complexed with metal ions. 

In this experiment the indicator used is Eriochrome black T (ErioT). When free, this indicator has 

a blue colour whereas when complexed with Mg2+ the colour becomes violet. 

An excess of EDTA is added to the standard Zn (II) ion solution (Sol P) to ensure that all Zn (II) 

ions are complexed. You will also add 20 μL of ErioT and the solution turns blue because ErioT is 

free in solution. 
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The excess of EDTA will then be back titrated with a solution of known concentration of MgCl2. 

The magnesium will react with EDTA.  

EDTA4-(aq) +  Mg2+(aq)    ⇄   [Mg(EDTA)]2-(aq) 

As soon as all the excess of EDTA is complexed with magnesium, the excess of magnesium added 

will react with ErioT forming a pink complex.  

Mg2+(aq)  + ErioT(aq)    ⇄   Mg-ErioT(aq) 

At this point the colour of the solution changes from blue to violet. The number of moles of MgCl2  

added until the indicator changes colour, is equal to the number of moles of EDTA in excess in 

relation to the Zn (II) ions. 

Since the total number of moles of EDTA added to the solution and the number of moles of MgCl2 

used in the back titration is known, it is possible to calculate the number of moles of Zn (II) ions 

and the concentration of Sol P.  

2 - 3.1.3. Titration of Sol P 

Use the funnel to fill the burette above the 0.00 mL mark with 0.0050 mol.L-1 MgCl2. Drop the 

excess of liquid (into the 500 mL plastic beaker for waste) so that the burette is filled precisely to 

the 0.00 mL mark.  

Note: Be careful not to have any air bubbles trapped in the valve of the burette. 

Prepare two 100 mL Erlenmeyer flasks 

In each of the 100 mL Erlenmeyer flasks add the following solutions: 

1. With a 5.0 mL pipette - transfer 5.0 mL of Sol P solution to the Erlenmeyer. 

2. With a 10.0 mL pipette - add 10.0 mL of 0.010 mol.L-1 EDTA solution.  

3. With a 5.0 mL pipette - add 5.0 mL of sodium carbonate-bicarbonate Buffer solution pH 10.5.  

4. With the 20 μL micropipette – add 20 μL of ErioT solution. 

Important notes on the titration:  

● You should perform two titrations, a first titration to determine the approximate position of 

the end point (as soon as the solution turns from blue to violet) and a second titration to 

determine accurately the end point. 

● On the first titration use the color of the solution of the second Erlenmeyer flask as a visual 

reference for the initial blue color of the solution, that will help you to determine the end 

point. 

● You should add small amounts of MgCl2 solution when in proximity of the end point.  

● No drop of MgCl2 solution after addition should remain on the walls of the Erlenmeyer. This 

could be a source of error. 

● Stir the Erlenmeyer flask manually between additions of MgCl2. 

Question 3.1.3.a 

Record the volume of MgCl2 corresponding to the end point of the titration. 
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❖ Enter the volume of MgCl2 under Question 3.1.3a in the answer sheet. 

Question 3.1.3.b 

Calculate the number of moles of Zn (II)  ions in 1.0 L of Sol P. You should indicate  the value with 

5 decimal places (this quantity is known as the molarity of the solution and is expressed in mol.L-

1).  

❖ Enter your calculations and result under Question 3.1.3.b in the answer sheet. 

Question 3.1.3.c 

Based on your titration results and calculations choose from the list below the correct mass of 

ZnSO4.7H2O that was used to prepare 0.500 L of the primary standard solution of Zn (II) ions (Sol 

P).  

a) 12.50 mg 

b) 125.0 mg 

c) 1.250 g 

d) 12.50 g 

❖ Circle your choice under Question 3.1.3.c in the answer sheet. 

Question 3.1.3.d 

Using the value chosen in Question 3.1.3.c, calculate the mass of Zn (II)  ions (in mg) in 1.0 L of 

Sol P. You should indicate the value with 1 decimal place. This value is the concentration of Sol P 

in mg.L-1 

❖ Enter your calculations and result under Question 3.1.3.d in the answer sheet. 

Question 3.1.3e 

❖ Calculate the initial Zn (II) concentration (Ci) in the 50 mL reaction flasks. Register 

the calculated Ci values in the answer sheet under Table 3.1.3.e and Tables 3.1.5.a 

and 3.1.5.b. 

 

Check your clock and be aware of the time of the biosorption experiment. To 

finish on time you should use any spare time left to read carefully section 2 - 3.1.4. 

and 2 - 3.1.5. prepare the material and perform all auxiliary calculations. 

 
2 - 3.1.4. Metal Quantification 

The concentration of free Zn (II) ions in the zinc-algae aqueous solutions is determined 

spectrophotometrically. Zinc forms a blue complex with zincon in a solution buffered to pH 9.0. 

The minimum detectable concentration is 0.02 mg.L-1  of Zn (II). The absorbance of the blue zinc–

zincon complex in solutions is read at 635 nm. 
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Figure 2 - 3.2 – Zincon complexation with divalent metal ions 

● Since you span a large interval of Zn (II) concentrations you will need to dilute some samples 

before you can follow the protocol to measure absorbance.  

● Using the four 10 mL volumetric flasks prepare diluted samples as follows: 

● Using the 200 μL micropipette transfer 200 μL aliquots of Red Sol P, Red 2.5×,  

Green Sol P and Green 2.5× zinc-algae solution to each of the four 10 mL 

volumetric flasks. Take the aliquots carefully to avoid taking algae particles with the 

sample.  

● Fill the four volumetric flasks to the mark line with   H2O. Do not forget to label the 

flasks with the indication of the dilution. 

You are ready to proceed with the quantification protocol: 

1. Prepare 12 plastic cuvettes (1 cm length/2 mL), 6 for each algae. 

2. Using the appropriate micropipette take aliquots directly from the 50 mL zinc–algae solution 

flasks (avoid taking algae particles with the sample) or from the previously prepared 

dilutions in the 10 mL volumetric flasks and transfer them to the plastic cuvettes according 

to the table below. Add H2O to the cuvette when indicated: 

 

 50× 25× 10× 5× 2.5× Sol P 

Flask of 

origin 

50 mL Zinc 

algae 

solution 

50 mL Zinc 

algae 

solution 

50 mL Zinc 

algae 

solution 

50 mL Zinc 

algae 

solution 

10 mL 

volumetric 

flask 

10 mL 

volumetric 

flask 

Volume to 

pipette 
200 μL 100 μL 20 μL 20 μL 200 μL 200 μL 

H2O 0 100 μL 180 μL 180 μL 0 0 

Total 

volume in 

cuvette 

200 μL 200 μL 200 μL 200 μL 200 μL 200 μL 
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3. You should have a total of 12 cuvettes, 6 for each algae, each with a total volume of 200 μL.  

4. Add reagents to the cuvettes in the following order with mixing between additions (use the 

cuvette cover):  

● 100 μL of sodium borate saline buffer solution, pH 9.0 

● 60 μL of zincon solution 

● 640 μL of H2O 

5. At this point each of your 12 cuvettes will have a total volume of 1000 μL. Connect and 

calibrate the colorimeter (see instructions for Vernier Colorimeter in Appendix 6). Use a 

cuvette filled with H2O for the blank. 

6. Read the absorbance of the blue zinc–zincon complex at 635 nm using the colorimeter.  

Question 3.1.4 

❖ Complete columns A.1 (Green algae) and B.1 (Red algae) in Table 3.1.4 in the 

answer sheet with the measured absorbance for each cuvette. 

 

2 - 3.1.5. Data analysis – Biosorption Isotherms  

The Lambert-Beer Law  

According to the Lambert-Beer law the concentration of a compound is related with its absorbance: 

  

This law predicts a linear relation between the absorbance reading (A), measured at a specific 

wavelength, and the concentration of compound (C), if (b), the cell or cuvette width, is kept constant. 

ε is a constant called absorptivity and is characteristic of the compound. 

For a given solution contained in a cuvette with a constant cell width, one can assume ε and b to be 

constant, k. This leads to the equation: 

A=k.C  

The following Lambert-Beer law curve is an example of a calibration curve obtained for a collection 

of Zn (II) standards of known concentration in a particular colorimeter. 
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Figure 2 - 3.1.5 – Example of a Lambert-Beer law plot for a collection of Zn (II) standards of different 

concentration.  

IMPORTANT: Each colorimeter has a calibration curve (A=k.C). Check 

the number (#) printed in your colorimeter (Col #) and use the 

corresponding value of k for your calculations. A list of k values for all 

colorimeters is available in Appendix 6.  

 

Question 3.1.5.a 

Using the relation between absorbance and concentration listed for your colorimeter calculate the 

concentration of Zn  (II) in the cuvette. 

❖ Register the number of your colorimeter and the value of k (A=k.C) in the answer 

sheet.  

❖ Using the Lambert-Beer law relation for your colorimeter, complete columns A.2 

and B.2 in Table 3.1.4 with the Zn  (II) concentration in each cuvette.  

Question 3.1.5.b 

❖ Calculate the final Zn  (II) concentration (Cf) in the 50 mL reaction bottles for:  

SolP, 5x, 25x and 50x for both algae. Write the calculation for one of them. Use the 

appropriate sections of question 3.1.5.b in the answer sheet to indicate the 

calculations. 

Question 3.1.5.c 

❖ Calculate the final Zn (II) concentration (Cf) in the remaining 50 mL reaction 

bottles for each algae. Complete Tables 3.1.5.a and 3.1.5.b. and with all the 

calculated Cf values in the answer sheet.  

Question 3.1.5d 

Zinc uptake capacity (q) is calculated after stabilization of Zn (II) concentration in solution. It is 

possible to know the quantity of Zn  ions removed by algae by the difference between the initial (Ci) 
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and final (Cf) metal concentration. By dividing this value by the quantity of algae (CA) used in the 

biosorption experiment, the uptake capacity is obtained: 

where Ci and Cf are the Zn  concentrations in mg.L-1 and CA is the algae quantity in g.L-1.  

❖ Calculate CA and the Zn  uptake capacity (q) for each algae. Register the values in 

the answer sheet under Tables 3.1.5.a and 3.1.5.b. 

IMPORTANT: If the majority of your q values are negative most probably you have 

the wrong concentration for Sol P. Consider using the value of 800.0 mg.L-1 and 

redoing the calculations of Ci. 

 

 

 

 

2 - 3.1.6. Determine the maximum Zn  (II) uptake capacity by approximation to a 
Langmuir isotherm 

The evaluation of the biosorbent is carried out considering the equilibrium relations (adsorption 

isotherms). You will use the Langmuir sorption model for the estimation of maximum sorbate 

(metal) uptake (qmax). The Langmuir isotherm can be expressed as: 

 

 

where q (the uptake capacity) is the amount of sorbate uptake, qmax is the maximum amount of 

sorbate uptake upon saturation of the surface, Cf the final concentration of the sorbate in solution (in 

mg.L-1) and b a constant related with the affinity of metal ions to the adsorption sites (in L.mg-1). 

The Langmuir model can be verified using the linear transformation of the previous equation: 

 
By plotting (1/q) versus (1/Cf),  qmax and b can be determined from the slope (m = 1/(qmaxb)) and the 

Y-intercept (c = 1/qmax) constants of a straight line (y = mx + c) that best fits the experimental points. 

 

Question 3.1.6.a 

Calculate 1/q and 1/Cf. Plot (1/q) versus (1/Cf ) for both algae. 

❖ Register the calculated values in the answer sheet under Tables 3.1.5.a and 3.1.5.b. 

Use the supplied millimetric paper sheet to draw the two plots of 1/q versus 1/Cf 

(draw the plots separately and do not forget to identify them). 

 
Question 3.1.6.b 

In the (1/q) versus (1/Cf ) plots draw the straight lines that best fit the experimental points for the 
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two algae.  

❖ Draw the straight lines that best fits the experimental points in the 1/q versus 1/Cf 

plot for the two plots (do not forget to identify them). Be aware that the Y-intercept 

must be a positive number. If you want to disregard the contribution of one or 

more experimental points to the straight line mark it with a cross 

within a circle ⊗, but a penalty will be applied.  

Question 3.1.6c 

Determine the slope (m) and the Y-intercept (c) of the straight lines that best fit the experimental 

points (y = mx + c) for both algae. 

❖ Calculate the slope (m) and Y-intercept (c) for the green algae and the red algae.  

Question 3.1.6d 

Finally, calculate qmax and b as follows: 

 
and  

 

❖ Enter your calculations and results of qmax and b under Question 3.1.6d in the 

answer sheet. 

 

Question 3.1.6e 

Based on your results for qmax and b which algae would you select to remove Zn  ions from 

wastewater?  

❖ Enter your choice under Question 3.1.6.e in the answer sheet. 
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APPENDIX 4 

Ti-Nspire 

4.1. Collecting data with the data logging Lab Cradle interface connected to a 

calculator with the TI-Nspire CX Software. 

1. In the computer launch the application TI-Nspire CX. Choose the option “Trial Version” 

2. In order to view the document in the computer mode make the following selection: 

 

3. Connect the sensor/ sensors to the Lab Cradle  

4. Connect the Lab Cradle to the computer using a mini USB to USB cable. 

5.  The program automatically detects the sensor/ sensors, showing you the following interface: 
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6. To adjust the sampling rate and define the acquisition duration by clicking on  and making 

your choices: 

 

Note that if the sampling rate is too low your plots will not have sufficient points.  

7. To start the collection click on   

8. The collected data can be visualized in a meter by selecting , in a graph by selecting  or in a 

table . 

9. Save your document choosing the “Save” or “Save as” option in the menu “File” or by clicking on  

 . 

10. You can read data points in a plot by clicking on the graph to position the cursor at the desired point: 

                                        

 

You can use the arrow keys to move the cursor. 
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11. To change the axes limits, write a new value over the current one: 

 

 

 

 

 

 

   

12. You can work out your data by: 

appending columns to your table, making calculations with data from existing columns and 

creating a new column with the results, plotting data from existing columns, making curve fits to 

your plots, etc. You can find some examples below. 

A set of collected data table looks like this: 

  

13. Append columns to the table to: 

● fill manually 

           

Then you can fill manually the new column: 
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14. Calculate data from existing columns (in the example the ln 

function is applied to the numbers in the column named “Potential” and 

the results are listed in a new column named “Calculated”) 

     

The result is: 

 

 

15. Plotting data in columns 

Select   and then select the variables x and y you want to plot: 
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Manual3 as a function of Manual2 will give: 

 

 

 

 

 

 

 

 

16. Making curve fits to plots 
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APPENDIX 5 

GLOSSARY 

PCR (Polymerase Chain Reaction)*- PCR is an in vitro amplification assay of DNA  that produces 

exponentially large amounts of a specific sequence of DNA (template).  

PCR amplification requires the presence of at least one DNA template strand, which can be any form of 

double-stranded DNA (in this case: DNA extracted from mussels). 

Specificity comes from the ability to target and amplify a specific segment of DNA out of a complete 

genome, which is done with adequate primers* (Figure 1).  
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Figure  1 – An example of the amplification of a DNA template by PCR: 1) Denaturation of double strand 

DNA at high temperatures); 2) Annealing of the primers (hybridization with the complementary sequence); 

3) Extension of new complementary DNA strands;  4) Denaturation of double strand DNA at high 

temperatures);  5) Annealing of the primers; 6) Extension of new complementary DNA strands; 7) 

Repetition of this reactions for several cycles. 

 

Primers*- are short chains of DNA that are complementary to the DNA template we wish to copy using 

PCR. Forward primers bind to the downstream (at the 3' end) and reverse primers bind upstream (at the 5' 

end) of the target region of interest (Figure 2). For a PCR reaction to occur you need to use a suitable pair of 

forward and reverse primers to generate a specific fragment of DNA (Figure 2). 
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Figure 2 – Forward and reverse primers annealed to a target DNA sequence during PCR. 

 

DNA molecular weight ladder*- Mixture of linear DNA fragments of known molecular weight used to 

estimate the size in base pairs (bp) of other DNA fragments. Schematic diagram of the expected band sizes 

of the DNA ladder used in this Task is indicated in Figure 3. 

 

Figure 3 – DNA molecular weight ladder used. DNA bands and their corresponding molecular 

weight (number of base pairs) are indicated in the figure. 

 

Orange G DNA Loading buffer*- Solution used to prepare DNA samples for loading on agarose gels. It 

contains a dye (orange) for visual tracking of DNA migration during electrophoresis and glycerol to 

increase the density of the sample.  

 

 

 

 

APPENDIX 6 

Ti-Nspire 
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3.1. Collecting data with the data logging Lab Cradle interface connected to a 

calculator with the TI-Nspire CX Software. 

 

1. Connect the calculator to the interface 

 

  

1 – Calculator 

2 – Interface 

 

 

 

 

 

 

 

 

2. Turn on the calculator. 

 

 

     1 – Switch On/Off 

 

 

 

 

 

 

 

 

 

 

3.2. Instructions for Vernier Colorimeter 

The Vernier Colorimeter is designed to determine the concentration of a solution by analysing its colour 

intensity. The Colorimeter measures the amount of light transmitted through a sample at a user-selectable 
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wavelength. 

There are two models: model 1 and model 2. 

 

 

Using the Colorimeter  

The Colorimeter is easy to use and maintain. Simply connect it to your data collection interface (TI 

graphing calculator), configure your software (Vernier LabPro®), and you are ready to make 

measurements. For best results, let the system stabilize at the desired wavelength for 5 minutes prior to 

calibration or data collection.  

General procedure to follow when using the Colorimeter  

1. Connect the Colorimeter to the interface in ch1 or ch2 or ch3. 

2. Turn on the TI Nspire 

3. Use the cursor with the Touchpad and press the icon  

 

4. The software will identify the colorimeter and load a default data collection setup.  

 

 

 

 

 

5. Press the “ < ” or  “ > ” button on the Colorimeter to select 

the correct wavelength setting for your experiment (430 

nm, 470 nm, 565 nm, or 635 nm).  
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6. Calibrate the Colorimeter. Note: The Colorimeter needs to be powered about 5 minutes before 

calibrating. One of the four green wavelength indicator lights will be turned on when it is powered. 

a. Open the Colorimeter lid.  

b. Insert a cuvette with the blank specified in your task. Important: Line 

up one of the clear sides of the cuvette with the arrow at the top of the 

cuvette slot. Close the Colorimeter lid. 

c. Next, press the CAL button to begin the calibration process. Release 

the CAL button when the red LED begins to flash. The absorbance 

should now be 0.00 or 0.01.  

d. When the LED stops flashing, the calibration is complete and your unit 

is ready to collect data.  

7. Collecting data. 

a. Place the cuvette with a sample into the Colorimeter cuvette slot. 

Important: Line up the side of the cuvette with an arrow with the arrow 

at the top of the cuvette slot.  

b. Read the absorbance value 

 

 

8. If the Colorimeter does not turn on - no green light -  ask your lab assistant for a different cradle.  
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Lambert-Beer calibration law for Zinc(II) determination for Vernier 

Colorimeter 

 

Col # 
k (A = k.C ) 

C in mg.L-1 
Co # 

k (A = k.C ) 

C in mg.L-1 
Col # 

k (A = k.C ) 

C in mg.L-1 

1 0.28 13 0.30 27 0.24 

2 0.23 14 0.27 28 0.25 

3 0.23 15 0.27 29 0.30 

4 0.22 16 0.28 30 0.21 

5 0.18 17 0.29 31 0.24 

6 0.22 19 0.29 32 0.22 

7 0.29 20 0.28 33 0.29 

8 0.25 21 0.26 34 0.23 

9 0.26 22 0.28 35 0.28 

10 0.27 23 0.29 

 11 0.26 24 0.29 

12 0.25 26 0.26 
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APPENDIX 7  

PIPETTING  

Pipette safety instructions 

● Mouth pipetting is forbidden! 

● Insert the top of the pipette in the bottom of the pipette filler carefully so as not to break the glass 

pipette. 

● Do not allow the liquid to be drawn into the bulb. 

 

 

Pipette filler bulb: (a) Air valve (expels air from the bulb), (b) Suction valve (draws solution into 

the pipette), (c) Empty valve (drains solution from the pipette). 

 


